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Requests to Customers

(1) The content of this manual may not be reproduced in its entirety or in part without prior

permission.

(2) The content of this manual is subject to change without notice.

(3) All possible measures have been taken to ensure that the content of this manual is accurate. If

you happen to notice errors, omissions or other faults, please contact Canon.

(4) Irrespective of items above, Canon cannot bear responsibility for any effects that results from

operation.

Icons Used in This Manual

Indicates notes of caution or limitations that must be kept in mind concerning operation. Be sure to

read these notes.

Indicates supplemental explanations or references that are useful for operation.

Indicates functions and specifications that are only available to VB150 users.

Copyright Information

Please note that copyright laws prohibit the customer from using recorded videos and still pictures for any purpose

other than personal enjoyment without permission from the copyright holder.

Trademarks

● Canon and Canon logo are registered trademarks of Canon Inc.

● Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the United States and

other countries.

● Windows is legally recognized as Microsoft Windows Operating System.

● All other company or product names used in this manual are trademarks or registered trademarks of their respective

holders.

c
Note

e
Tip

Introduction

Thank you for purchasing WebView Livescope MV Ver. 2.1. Please read this manual

prior to use to ensure that you will be able to use this software effectively.

When you finish reading this manual, please store it in a safe place.

The latest product information is available at the following Web site.

http://www.canon.com/webview/

VB150
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Overview

WebView Livescope MV Ver. 2.1 is software that allows you to use an Intranet or the Internet to

monitor images distributed from the Network Camera Server VB150/VB101 or the Network Camera

VB-C10/VB-C10R (hereafter referred to in this manual as "camera server").

This software consists of two packages: WebView Livescope MV Manager, that lets you create

monitoring screens or have centralized control of several camera servers; and WebView Livescope

MV Station, that lets you monitor images from cameras in multiple locations and easily download,

view, save, and manage pictures recorded in the camera server.

Since MV Manager uses the wizard format for registering camera servers or creating monitoring

screens, there is no need to learn complex operations. You can also have centralized control

(changing settings or confirming operating conditions) of camera servers installed in multiple

locations.

Monitoring screens can be created by selecting from a rich variety of screen styles to best suit the

size of the monitor, the number of camera servers and cameras, and monitoring objectives. It is

also possible to perform such tasks as editing maps, changing the allocation of camera servers on

the maps, or making settings for automatic operation based on schedules.

MV Station lets you access MV data created in MV Manager, freely remote control cameras, and

simultaneously view images from camera servers installed in multiple locations (up to 16 locations),

providing an efficient monitoring environment.

In MV Station, you can easily view and manage still pictures recorded by the camera server’s

picture recording function and automatically download them. Smoother and more accurate

monitoring is possible due to functions that simplify access procedures for downloading recorded

pictures or that display only the images that have been changed.

* When using VB101, upgrade the firmware to version 3.0.

Changes from MV Ver. 2.0 to Ver. 2.1 are as follows:

Added support for the Network Camera Server VB150

Canon Remote Control Pan-tilt Head NU-700 (see p. 59)

The VB150 with the Video Input set to Multiple (see p. 77)

Motion detection function (see p. 80)

e
Tip
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Router

Distributes video and 
picture data.

Records pictures 
according to 
schedules

Video Sender

Video Sender

Video Sender

VC-C4R

VB101

VC-C4

VB-C10

Monitoring via Internet 
is also possible

Monitoring via ISDN line

MV Station
Monitoring

Router
Transmits settings 
data such as camera 
direction, zoom, etc.

VC-C4

VB150

NU-700

ISDN Line

I N T E R N E T

System Configuration

MV Manager and MV Station connect to camera servers via TCP/IP. Connections can also

be made over the Internet or an Intranet.
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MV Station
Monitoring

MV Manager

Creating monitoring screens/ 
Remote maintenance

Application Function

WebView Livescope 
MV Manager

■ Application Types and Functions

WebView Livescope 
MV Station

Lets users monitor images from several cameras from monitoring screens 
created in MV Manager. Downloading, viewing and saving of pictures recorded 
in the camera servers are also possible.

Transmits settings data such 
as camera direction, zoom, etc.

Transmits camera 
server settings and changes

E T H E R N E T

Lets users create and edit monitoring screens (MV data) to be used in MV 
Station. Remote centralized control of several camera servers is also possible.

L A N
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Tasks To Perform Prior To Monitoring

Registering Camera Servers1

Creating Monitoring Screens2

MV Manager

MV Manager

The first step is to register the camera servers.

The procedures in the wizard-style format

make the registration process very easy.

The wizard-style format is also used for creating

monitoring screens. Creating screens that suit your

application is very easy.

Before you can start monitoring, you need to perform the required settings as described in "Registering

Camera Servers" (Chapter 2), "Creating Monitoring Screens" (Chapter 3), and "Exporting MV Data"

(Chapter 4).
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Monitoring4

Exporting MV Data3

MV Station

MV Manager

MV Data 
folder

You must create an MV Data folder and

perform a task known as Exporting in order to

view images on the monitoring screen.

Monitoring is possible by accessing this MV

Data folder.
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WebView Livescope MV Manager

WebView Livescope MV Station

CPU Pentium III 600 MHz or better

Windows Me/ Windows 2000 (Service Pack 1 or later)/ Windows XP

Internet Explorer 5.0 or later required

Operating System
Web Browser

128 MB or betterMemory
Available space of 50 MB or betterHard Disk
XGA (1024 × 768) or better with high-resolution 16-bit color display or betterMonitor

CPU Pentium III 600 MHz or better

Windows Me/ Windows 2000 (Service Pack 1 or later)/ Windows XP

Internet Explorer 5.0 or later required

Operating System
Web Browser

128 MB or betterMemory
Available space of 50 MB or betterHard Disk
SVGA (800 × 600) or better with high-resolution 16-bit color display or betterMonitor

When using VB101, upgrade the firmware to version 3.0. The firmware is

available for free at the following Web site:

http://www.canon.com/webview/

c
Note

Operating Environment



Chapter 1
Installing

First, you need to install WebView Livescope MV Manager and WebView
Livescope MV Station.
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When Monitoring with One PC

When Using Several MV Stations

Install MV Manager. MV Station will also be installed automatically (see p. 15).

Install MV Manager in one PC and MV Station in several PCs. MV Manager exports information

for monitoring into the MV Data folder for MV Station to access. MV Station accesses the files

exported to this MV Data folder in order to display images from the cameras on the monitoring

screens.

MV Manager

Creating monitoring screens/ 
Remote maintenance

MV Station
Monitoring

VB150/VB101

Check the System Configuration

MV Manager

Creating monitoring screens/ 
Remote maintenance

MV Station
Monitoring

Receives videos 
and controls 
camera 

File sharing

VB150/VB101

Refers to camera server information 
and monitoring screen settings

Camera server 
settings and changes

MV Data folder

MV Station
Monitoring

VB-C10

Prior to Installation...
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If you want to access the MV Data folder from an environment (outside the same LAN) in which

it cannot be shared, place it and make it available in a file server where it can be accessed. In

this case, before starting installation, the PC in which the MV Data folder is to be placed must

be set so that the folder can be shared. Prepare a folder and set it to Share so that it can be

accessed over the network from the PC where MV Station is installed.

If several MV Stations are used and MV Data folders are placed in
locations other than the PC where MV Manager is installed

MV Manager

Creating monitoring 
screens/Remote 
maintenance

MV Station
Monitoring

Receives videos 
and controls
camera 

File sharingVB150/VB101

Refers to camera server information 
and monitoring screen settings

Exports camera server information 
and monitoring screen settings

Camera server 
settings and changes

MV Data folderFile server
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Preparing the Computers

Installing the Camera Servers

First, you need to check your camera server. If the VB-C10/VB-C10R or VB150 is being used, there

is no need to upgrade the firmware. However, if the VB101 is being used, check that the firmware

version is 3.0 or later. See page 10 for details about the firmware upgrade.

Check to be sure the camera server has been correctly installed and that the initial settings

(network settings) have been made. Then connect to the network. You can perform detailed

settings or view tests from MV Manager. For procedures on installing and setting up the camera

server, please see the manual supplied with the camera server.

• At the PC where MV Manager is to be installed, set the

screen resolution to XGA (1024 × 768) or higher.

• At the PC where MV Station is to be installed, set the

screen resolution to SVGA (800 × 600) or higher. Be

sure the resolution that you set is the same or higher

than the optimum resolution of the monitoring screens

created in MV Manager (see p. 30).

Display Properties

c
Note

● "Maximum Number of Clients" must be set to five or more for the VB150 (or

VB101) and to two or more for the VB-C10/VB-C10R.  To make settings for

the VB101, use the "Application Settings Page", and for the VB150 or VB-

C10/VB-C10R, use the "WebView Livescope Settings Page". While default

settings meet the above requirements, the settings must be checked if any

changes have been made.

● If a connection was made from MV Station via a proxy server, notification of

external device input (see p. 78), external device output control (see p. 79),

notification of motion detection (see p. 80) as well as the External Device

Input Log Viewer (see p. 98) will not work.

Prior to Installation...
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Installation Procedures

Starting Up the Installer

When you load the WebView Livescope MV Ver. 2.1 installer CD-ROM into the PC, the main

panel of the installer automatically appears. If it does not appear, in Explorer, double-click

"\mv2setup.exe" on the CD-ROM.

Click the buttons to start up the installer and proceed with installation.

●  Install MV Manager
This button installs both MV Manager and MV Station. This setup is for administrators who manage the

camera servers and create monitoring screens.

●  Install MV Station
This button installs MV Station only. This setup is for operators who view monitoring screens.

When you place the mouse

cursor on these buttons,

explanations about them appear

below the cursor.

c
Note

This product consists of MV Manager and MV Station for one client. If

additional MV Station installations are required, please purchase separate MV

Station licenses.
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Installing MV Manager

When you click the Install MV Manager button on

the main panel, the installer starts up and the

process of installing MV Manager begins. Click Next

to continue the installation.

Enter the Serial number and click Next. The Serial

number is indicated on the seal attached outside the

software package.

A screen appears where you can specify a folder in

which MV Manager is to be installed.

To specify a folder other than the one indicated, click

Browse and select the folder you want.

When the folder has been specified, click Next.

c
Note

If you are installing WebView Livescope MV Ver. 2.1 into a PC in which Ver. 1.0

is already installed, information such as the camera servers and monitoring

screens that were registered and set with Ver. 1.0 cannot be used with Ver.

2.1. However, if Ver. 2.0 is installed, the information registered and set with

Ver. 2.0 can be used with Ver. 2.1.

Specify a name to be registered in the Program

menu under the Start menu, then click Next.

1

2

3

4
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Installation Procedures

Check the items you have specified and selected

thus far, then click Next. The installation will be

performed by copying files and setting the registry.

When installation is complete, click Finish to exit the

installer.

Installing MV Station

When you click the Install MV Station button on the

main panel, the installer starts up and the process of

installing MV Station begins. Click Next to continue

the installation.

Enter the Serial number and click Next. The Serial

number is indicated on the seal attached outside the

software package.

c
Note

If you are installing WebView Livescope MV Ver. 2.1 into a PC in which Ver.

1.0 is already installed, information such as the work folders that were set

with Ver. 1.0 cannot be used with Ver. 2.1. However, if Ver. 2.0 is installed, the

information registered and set with Ver. 2.0 can be used with Ver. 2.1.

5

1

2

6
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Installation Procedures

● After MV Manager and MV Station have been installed, make the following
settings if connections are to be made via a proxy server.c

Note

To make proxy settings, in MV Manager, choose
Option from the Tools menu and click the "HTTP
proxy" button, and in MV Station, choose
Network from the Option menu and click the
HTTP Proxy button.

A screen appears where you can specify a folder in

which MV Station is to be installed.

To specify a folder other than the one indicated, click

Browse and select the folder you want.

When the folder has been specified, click Next.

Specify a name to be registered in the Program

menu under the Start menu, then click Next.

Check the items you have specified and selected

thus far, then click Next. The installation will be

performed by copying files and setting the registry.

When installation is complete, click Finish to exit the

installer.

3

4

5

6

● If you have changed the HTTP port number (normally it is 80) at the camera
server, select that camera server on MV Manager, click the Properties button
on the Toolbar and be sure to change the HTTP port number on the Network
tab (see p. 99). Since MV establishes an HTTP connection when it starts up,
you need to specify the HTTP port even when Auto-select or WV-TCP is
selected as the connection protocol.



Chapter 2
Registering Camera Servers
Next, WebView Livescope MV Manager is used to register and set camera
servers.
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To register a camera server, first start up MV Manager. To start up MV Manager, double-click the desktop

icon or click the Start button and choose MV Manager from the Programs menu.

Screen Configuration

Starting up from the Start menu

This screen is used to add a camera server to be monitored or set a camera server.

"Camera Server"

An icon represents the

camera server that has been

created.

"Menu" "Toolbar"

Menu

"Navigation bar"

Main window switches

between Camera Servers and

Monitoring Screens.

Starting up from the desktop icon

Camera Server

Camera Server

"Register Camera Server"

Starts up the wizard for registering a camera server.

"Search/Register Camera Server"

Auto searches camera servers and starts the wizard for registering a
camera server.

"Open Setup Page"

Opens the selected camera server’s settings page in the Web browser.

"Properties"

Displays the properties of the selected camera server.

"Export"

Exports MV data.

"Delete"

Deletes the selected camera server.

Registering Camera Servers
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Toolbar

"Register Camera Server"

Starts up the wizard for registering a camera server.

"Search/Register Camera Server"

Auto searches camera servers and starts the wizard for registering a
camera server.

"Export"

Exports MV data.

"Open Setup Page"

Opens the selected camera server’s settings page in the Web browser.

"Properties"

Displays the properties of the selected camera server.

"View Test"

Conducts video tests.

"Rename"

Changes the name of the camera server.

"Exit"

Exits MV Manager.
Edit

"Select All"

Selects all camera servers.

"Invert Selection"

Changes selection from selected camera servers to ones that are not
selected.

View

"Toolbar/Status Bar"

Shows or hides the Toolbar/Status Bar.

"Camera Servers/Monitoring Screens"

Switches between the camera server list and the monitoring screen
list.

"Large Icons/Details"

Changes icon display
Tools

"View Test"

Conducts video tests.

"Upgrade Firmware"

Upgrades camera server firmware. (for VB101 only)

"Refresh"

Updates displayed information to the latest information.

"Option"

Changes the selected camera server connection settings and the
export data settings.
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Camera Server Registration Wizards

The first task to perform in MV Manager is to register camera servers that are to be monitored. To add a

camera server, simply follow the easy instructions in the wizard-style screens. There are two wizards: the

Register Camera Server wizard, which is used to enter the network address for the camera server; and the

Search/Register Camera Server wizard, for auto detecting camera servers connected to the network.

Select Camera Servers on the Navigation bar, and

click Register Camera Server on the Toolbar. When

the wizard startup screen appears, click Next.

In the "Network address" field, enter an IP address

or host name for the camera server being added.

The HTTP port number set as a property (see p. 99)

of the camera server appears as a default in the

HTTP port field. Although the HTTP port number is

usually 80, if another value is preferred, enter that in

the HTTP port field and click Next.

Step 1

Start up the
Register Camera

Server Wizard

Step 2

Enter a network
address for the
camera server

Step 3

Enter a name
and comment
for the camera

server

Step 4

Complete the
settings

Registering a Camera Server

Step 1: Start up the Register Camera Server Wizard

Camera servers are registered in the following 4 steps:

Step 2: Enter a network address for the camera server

1

2 Camera server information is retrieved at the

entered network address. Enter the Administrator ID

and Password in the window that appears, and click

OK.
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You can give the camera server any name you wish.
Enter the name in the "Camera server name" field.
This field cannot be left blank. It is also not possible to
give the same name to more than one camera server.
You can type any comment you wish for the camera
server in the Comment field. This comment is reflected in
"Comment" found in MV Manager, the monitoring screen
and other areas, and can be used for making
confirmations, etc. Several lines can be entered. It can also
be left blank. When finished with this screen, click Finish.

e
Tip

● The device name that was entered and set in the camera server’s settings page is
reflected in the "Camera server name" field as a default. If this setting was not
made, the network address that was entered in part       of Step 2 is reflected as a
default instead. In the case of VB-C10/VB-C10R, the network address is reflected
from the beginning.

● Comments such as the
installation conditions of the
camera server, the position of
cameras connected to the
camera server, or the objects
being monitored are convenient
when several camera servers
and cameras are being
operated.

The camera server is registered.

When OK is clicked in Step 2, an error message appears in the following

cases (see p. 113 for details):

● MV Manager cannot connect to the camera server, because the camera

server is not correctly connected to the network, the power switch on the

camera server is not turned on, etc.

● The network address was not entered correctly (entry error).

● The camera server setting does not permit MV Manager to access it.

● The VB101 firmware has not been upgraded to Ver. 3.0.

e
Tip

Step 3: Enter a name and comment for the camera server

Step 4: Complete the settings

1
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e
Tip

● Please conduct a view test (see p. 64) to check to be sure that the camera

server has been correctly set.

Adding more than one camera server

Up to 100 camera servers can be registered. To add more than one camera

server, repeat steps 1 through 4.

Deleting a camera server

To delete the registered camera server, select the camera server by clicking

on it, then choose Delete from the Camera Server menu. When the camera

server that was being used in the created monitoring screen is deleted, it is

also deleted from the monitoring screen at the same time, and there is a

possibility that displays will not appear correctly in the monitoring screen.
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Click Search/Register Camera Server on the

Toolbar. When the wizard startup screen appears,

click Next.

Camera servers connected to the network are

automatically searched.

* If HTTP port other than 80 is used, the Search/

Register Camera Server feature will only be

available with the VB150. For other camera

servers, please use the Register Camera Server

registration procedure described on page 22.

Step 1

Start up the
Serch/Register
Camera Server

Wizard

Step 2

Search for and
register the

camera server

Step 3

Complete the
settings

Searching/Registering Camera Servers

Step 1: Start up the Serch/Register Camera Server Wizard

Camera servers are searched and registered in the following 3 steps:

Step 2: Search for and register the camera server

Camera Server Registration Wizards

1

2 From the list of detected camera servers, select the

one you want to register by clicking on it, then click

the Register button. Enter the Administrator ID and

Password in the window that appears, then click OK.
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Camera Server Registration Wizards

A dialog box for confirming camera servers to be

registered appears. If you are satisfied with the list,

click Finish to complete registration. If you click

"Detected Camera Servers", the screen returns to

Step 2.

Camera server search and registration is not possible in the following cases

in Step 2 or later:

● The camera server is not on the same LAN. (In this case, register the

camera server from "Register Camera Server". see p. 112.)

● MV Manager cannot connect to the camera server, because the camera

server is not correctly connected to the network, the power switch on the

camera server is not turned on, etc.

● The camera server setting does not permit MV Manager to access it.

● The VB101 firmware has not been upgraded to Ver. 3.0.

c
Note

Step 3: Complete the settings

1

2 The camera servers are automatically given names.

If you want to change a name, click the camera

server icon to select it, then right click on the

selection. When the pop-up menu appears, choose

"Rename". Alternatively, you can double-click on the

camera server icon to display the camera server’s

properties. Click the General tab and change the

name there.

e
Tip

● Please conduct a view test (see p. 64) to check to be sure that the camera

server has been correctly set.

● Up to 100 camera servers can be registered.

3 The camera server to be registered appears in the
space below. To register more than one camera
server, repeat the process of selecting a camera
server, cl icking Register, and entering the
Administrator ID and Password for each camera
server you want to register. Camera servers with the
same Administrator ID and Password can be
selected in multiples and registered at one time.
When finished, click OK.



Chapter 3
Creating Monitoring Screens

Using WebView Livescope MV Manager to create monitoring screens

appropriate to your application.
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"Menu" "Toolbar"

"Monitoring Screen"

An icon represents the

monitoring screen that has

been created.

This screen is used to create and edit monitoring screens.

Monitoring Screen

Menu

Monitoring Screen
"Create Monitoring Screen"
Starts up the wizard to create a monitoring screen.
"Properties"
Displays the properties of the selected monitoring screen.
"Export"
Exports MV Data.
"Delete"
Deletes the selected monitoring screen.
"Rename"
Changes the name of the monitoring screen.
"Exit"
Exits MV Manager.

Edit
"Select All"
Selects all monitoring screens.
"Invert Selection"
Changes selection from a selected monitoring screen to ones that are
not selected.

View
"Toolbar/Status Bar"
Shows or hides Toolbar/Status Bar.
"Camera Servers/Monitoring Screens"
Switches between the camera server list and the monitoring screen list.
"Large Icons/Details"
Changes icons display.

Screen Configuration

"Navigation Bar"

Main window can be switched

between Camera Servers and

Monitoring Screens.

Creating Monitoring Screens
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Toolbar

"Create Monitoring Screen"
Starts up the wizard to create a monitoring screen.
"Export"
Exports MV Data.
"Properties"
Displays the properties of the selected monitoring screen.
"Edit Map"
Lets you edit the map.

Tools
"Edit Map"
Lets you edit the map.
"Option"
Changes camera server connection settings and proxy settings.
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Create Monitoring Screen Wizard

When you have finished registering the camera servers, the next task is to create monitoring screens.

Various monitoring screens can also be created easily by operating in accordance with directions from a

wizard screen. The five steps required are as follows:

Step 1:

Start up the
Create

Monitoring
Screen Wizard

Step 2:

Select a
monitoring

screen

Step 3:

Select cameras

Step 4:

Enter monitor-
ing screen
name and
comments

Select Monitoring Screens on the Navigation bar

and click Create Monitoring Screen on the Toolbar.

When the wizard startup screen appears, click Next.

Select a monitoring screen.

(1) Select one of the four types of monitoring screen

with the buttons at the top left (see p. 33).

(2) Select one of the four types of display sizes with

the radio buttons at the top right.

(3) Different combinations of monitoring screen type

and display size will cause the details shown in

the Viewer Arrangement box at the bottom left to

be changed. (For viewer arrangements, refer to

"Viewer Arrangements" on p. 34)

Step 5:

Complete the
settings

Step 1: Start up the Create Monitoring Screen Wizard

Step 2: Select a monitoring screen
Select "Type of monitoring screen"

and "Display Size of MV Station"

Display "Monitoring screen preview" by

selecting "Viewer Arrangement"

1

2 When you click a viewer arrangement, a sample

screen will appear in the "Monitoring screen

preview" window at the bottom right.

Here, we shall try creating a monitoring screen by

selecting "United Window A", "XGA(1024 × 768)",

"Preview Type L1 + P5A(320 × 240,160 × 120)".

Having made the selection, click Next to continue.
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Select the camera server and camera you wish to

display in the monitoring screen.

Make your selection by checking the name of the

camera server and the name of the camera on the

list of camera servers and cameras available for use

(the camera servers registered in Chapter 2 and

connected cameras) that is displayed. (All cameras

are selected by default.)  When you select a camera

server, all cameras connected to that camera server

will be selected.

For Camera Control Right, select "MV level" (Refer

to p. 105 for details).

Having made the selection, click Next to continue.

Step 3: Select cameras

You can choose any name you wish for the

monitor ing screen. Enter the name in the

"Monitoring screen name" field. It must not be left

blank. You may not use the same name for more

than one monitoring screen.

You can use the Comment field to write any

comment you wish about the monitoring screen.

Comment will be reflected in the monitoring screen’s

"Comment"  sect ion and can be used for

confirmation. Several lines are available, or the

comment may be omitted.

Clicking the Settings button of "Main video pattern"

will enable you to make settings for the cameras that

are to be allocated on the viewer window when the

MV Station was started up. Select by clicking the

cameras you wish to allocate, then click the Assign

button.

Step 4: Enter monitoring screen name and comments

1

2

e
Tip

If Create Map is selected in Step 2, Map Editor will start after the settings are

completed in Step 5 and you can make a map. Even if it is not selected, you

can still make a map by starting Map Editor after this wizard is finished (see p.

40).



32

When you click Finish, the monitoring screen will be

created.

Step 5: Complete the settings

3 The allocated cameras will be arranged in the order

in which they are allocated and given a number in

the viewer window. If you wish to alter the sequence,

select an allocated camera by clicking its name and

shift the sequence by clicking the Up or Down

button.

When the allocation is completed, click OK.

● Even when the monitoring screen has been created and the settings are

completed, the settings are only stored by MV Manager and cannot be

viewed by MV Station. To view them on MV Station they must be exported

(see p. 46).

● Up to 100 monitoring screens can be registered.

c
Note
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Create Monitoring Screen Wizard

e
Tip

Monitoring Screen List

By means of viewer arrangements that can be selected in each of four types of

screens, 437 types of monitoring screens are available.

● Type of monitoring screen

United Window A

A pattern in which the camera source

window, viewer and camera control panel

are all united.

United Window B

A pattern in which the camera source

window and viewer are united and the

camera control panel is separated.

Separated Window B

A pattern in which the camera source

window, viewer and camera control panel

are all separated.

Separated Window A

A pattern in which the viewer and camera

control panel are united and the camera

source window is separated.

■ Screen configuration

Camera source window Viewer

Camera control panel
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Name of 
Arrangement

Display size

Sketch of Arrangement Type of 
monitoring 
screen

United 
Window A

SVGA
800

×
600

SXGA
1280

×
1024

UXGA
1600

×
1200

XGA
1024

×
768

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

Matrix Type 
1×1

c

d

d,e

d

e

d

d,e

d,e

e

d,e

e

e

e

e

Matrix Type 
1×2

b

b,c

c

c,d

d

d

d

e

e

e

Matrix Type 
1×3

b c

Matrix Type 
2×1

b

b

c

c

d

d

d

e

d

d,e

Matrix Type 
2×2

b

b

b

c

b

c

c

d

c

d

d

e

d

d,e

●  Viewer Arrangements

Different types of viewer arrangements can be selected according to the types and sizes

of screens.

●  Viewer Sizes

a: 160 × 120

b: 240 × 180

c: 320 × 240

d: 480 × 360

e: 640 × 480



C
reating M

onitoring S
creens

3

35

Create Monitoring Screen Wizard

a

a

b

a,b

b

c

c

c d

d

a

a

a

b

b

c

c

a

a

b

b

b

c

b

c

c

c

a

a

a

b

a

b

b

c

b

c

c

c

a

a

a

b

b

b

c

c

a

a

a,b

b

a,b

b,c

Name of 
Arrangement Sketch of Arrangement

Matrix Type 
2×3

Matrix Type 
2×4

Matrix Type 
3×1

Matrix Type 
3×2

Matrix Type 
3×3

Matrix Type 
3×4

Matrix Type 
4×1

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

SVGA
800

×
600

SXGA
1280

×
1024

UXGA
1600

×
1200

XGA
1024

×
768

Display size
Type of 
monitoring 
screen
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a

a

a,b

b

b

a,b

b

b,c

a

a

a

a,b

a

b

a,b

a,b

a,b

b,c

a

a

a

a,b

a

b

a,b

a,b

a,b

b,c

a

a

b

a,b

a,b

c

c

c

c

a

a

b

b

b

c

b

c

c

c

c

a

a

a,b

b

b

b,c

b

b,c

Name of 
Arrangement Sketch of Arrangement

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

Matrix Type 
4×2

Matrix Type 
4×3

Matrix Type 
4×4

Preview Type
 L1+P2B

Preview Type
 L1+P4A

Preview Type
 L1+P2A

SVGA
800

×
600

SXGA
1280

×
1024

UXGA
1600

×
1200

XGA
1024

×
768

Display size
Type of 
monitoring 
screen

●  Viewer Sizes

a: 160 × 120

b: 240 × 180

c: 320 × 240

d: 480 × 360

e: 640 × 480
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Create Monitoring Screen Wizard

a

a

a,b

b

b

b,c

b

b

a

a

a

b

a

b

b

c

b

c

c

c

a

a

a

b

a

b

b

c

b

c

c

c

a

a

a

b

a

b

b

c

b

c

c

c

d

a

a

a

b

a

b

b

c

b

c

c

c

d

a

a

a

a

b

b

c

c

a

a

a

a,b

a

b

a,b

b,c

a,b

b,c

Name of 
Arrangement Sketch of Arrangement

Preview Type
 L1+P4B

Preview Type
 L1+P5A

Preview Type
 L1+P5B

Preview Type
 L1+P5C

Preview Type
 L1+P5D

Preview Type
 L1+P8A

Preview Type
 L1+P8B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

SVGA
800

×
600

SXGA
1280

×
1024

UXGA
1600

×
1200

XGA
1024

×
768

Display size
Type of 
monitoring 
screen
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a

a

a

a

b

b

c

c

a

a

a

a,b

a

b

a,b

b,c

a,b

b,c

a

a

a

a,b

a

b

a,b

b,c

a,b

b,c

a

a

a

a,b

a

b

a,b

b,c

a,b

b,c

a

a

a

a,b

a

b

a,b

b,c

a,b

b,c

a

a

a

a,b

a

b

a,b

b,c

a,b

b,c

Name of 
Arrangement Sketch of Arrangement

Preview Type
 L2+P4A

Preview Type
 L2+P4B

Preview Type
 L2+P8A

Preview Type
 L2+P8B

Preview Type
 L2+P8C

Preview Type
 L2+P8D

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

SVGA
800

×
600

SXGA
1280

×
1024

UXGA
1600

×
1200

XGA
1024

×
768

Display size
Type of 
monitoring 
screen
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Create Monitoring Screen Wizard

●  Viewer Sizes

a: 160 × 120

b: 240 × 180

c: 320 × 240

d: 480 × 360

e: 640 × 480

a

a

a

a

b

b

c

c

a

a

a

a,b

a

b

a,b

b,c

a,b

b,c

a

a

a

a,b

a

b

a,b

b,c

a,b

b,c

a

a

a

a,b

a

b

a,b

b,c

a,b

b,c

a

a

a

a,b

a

b

a,b

b,c

a,b

b,c

a

a

a

a,b

a

b

a,b

b,c

a,b

b,c

Name of 
Arrangement Sketch of Arrangement

Preview Type
 SL1+P3A

Preview Type
 SL1+P3B

Preview Type
 SL1+P7A

Preview Type
 SL1+P7B

Preview Type
 SL1+P7C

Preview Type
 SL1+P7D

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

United 
Window A

United 
Window B

Separated 
Window A

Separated 
Window B

SVGA
800

×
600

SXGA
1280

×
1024

UXGA
1600

×
1200

XGA
1024

×
768

Display size
Type of 
monitoring 
screen
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Editing Maps

The map that is displayed on the monitoring screen enables the allocation of camera server, camera, external
device and motion detection (for VB150 only) icons and the background picture to be edited. These can be edited
with Map Editor. Map editing is not something that needs to be done when the monitoring screen is created; it can
be done when necessary.

Configuration of the Map Editor Screen

"Icons"

"Background Bitmap"

"Menu"

Save
Saves changes to
file

Save and Close
Saves changes to
file and closes Map
Editor

Close
Close Map Editor
w i t h o u t  s a v i n g
changes

Load Background Bitmap
Reads map background
bitmap file

Clear Background Bitmap
Clears background bitmap
(so that nothing is written)

Change Icon
Changes the image of the
selected icon

Delete Icon
Deletes the selected icon

Starting up Map Editor

Select the Monitoring Screens on the

Navigation bar and click the monitoring

screen icon to select it. Then, click the Edit

Map on the Toolbar.

Also, if you select Create Map in Step 2 of

the Create Monitoring Screen Wizard and

continue with the wizard, the Map Editor will

start up automatically when the creation is

completed.

It is possible to make changes
to the supplied sample bitmap
files and user-created images.

Enables camera server, camera, external
device input/output and motion detection (for
VB150 only) icons to be dragged and dropped.
Also lets you switch and control the camera
server and camera. Bitmap  icons can  be
selected from the list on  page 43.
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c
Note

Loading and Changing Background Bitmaps

The Open dialog box will appear when you

select Load Background Bitmap from the

Tools menu.

The folder containing previously prepared

sample bitmap files is in the folder with MV

Manager installed. (Default is C:\Program

Files\Canon\WebView\Mv\2.0\Bmp).

Select by clicking the bitmap file you wish to

use, click Open and the bitmap will be

loaded into background. The bitmap will be

displayed inside a dotted frame. You can

alter the size of the frame by dragging the

square on the right edge, right bottom edge

and bottom edge.

Background bitmaps can be loaded from user-created bitmap files. The

following file types can be used as background bitmaps.

●  Bitmap files (extension .bmp)

●  JPEG files (extension .jpeg/jpg)
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Allocating Icons

You can freely allocate the icons shown in

the tree in the left window by dragging and

dropping them onto the map.

There are five types of icons (see p.43),

"Camera Server",  "Camera", "Input",

"Output" and "Motion Detection" and camera

server names, camera names and input/

output/ motion detection descriptions applied

by the MV Manager  camera server

properties are displayed. The camera server

icon and the camera icons of the camera

connected to its camera server cannot be

allocated on the map at the same time.

* Motion detection is only available with the

VB150.

When an icon is to be dropped, Select Icon

dialog box will appear to enable the type of

icon to be selected. Icons will be allocated

when you have selected them and clicked

OK.

Once an icon has been allocated, it can be

freely reposi t ioned by dragging and

dropping. Also, if the type of icon is to be

altered, select Change Icon from the Tools

menu. When an icon is to be deleted, select

Delete Icon from the Tools menu.
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Editing Maps

e
Tip

List of Bitmap Icons

There are 90 bitmap icons.

Camera Server Icons

Camera Icons

VC-C4R CameraVC-C4 Camera

VB-C10 
Camera Server

VB150/VB101 
Camera Server

VC-C1 CameraVC-C3 Camera

NU-700 Camera

Other cameras

Other than cameras

VB-C10R 
Camera Server

External Device Icons

Input Icons

Motion Detection
 Icons

(VB150)

Output Icons
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Editing Maps

On the File menu, choose Save to save changes. If you choose Save and Close, the changes are

saved and Map Editor quits. Choose Close if you do not want to save the changes.

Since this save operation occurs in MV Manager, to

reflect the changes on the monitoring screen for

viewing in MV Station, you need to "Export" the

changes.

Saving the Edited Screen

Allocating Camera Icons with Scopes

A camera icon with a scope attached is one that

has "Icon rotates" indicated in the "Description"

column under "Select Icon". The icon and scope

will move in accordance with the horizontal

orientation and zoom of the actual camera.

When these icons are allocated on a map, a

guide is displayed for determining which of four

directions is to be the initial orientation. The

home direction of the camera can be specified

by dragging this guide.

e
Tip

Rotation is in the direction of the drag operation



Chapter 4
Exporting MV Data

Exports data of registered camera servers and created monitoring
screens.
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● Only a folder can be specified for the MV Data folder; a drive cannot be

specified.

● If MV Manager and MV Station are installed in separate PCs, a folder that

can be accessed by MV Station must be specified as the MV Data folder.

● If the MV Data folder being specified is in a different PC from the one where

MV Manager is installed, a folder that can be accessed by both the PC

where MV Manager is installed and the PC where MV Station is installed

must be specified as the MV Data folder.

c
Note

1

2 Next, specify the folder to which MV Data is to be

exported. Click the Browse button on the "Folder to

export", select the MV Data folder, and click OK.

Please note that the MV Data folder to be specified

cannot be created in this dialog box; the folder must

be created beforehand.

Monitoring screens cannot be viewed in MV Station simply by creating them and saving the settings in MV

Manager. To view monitoring screens in MV Station, you need to specify an MV Data folder that MV

Station can access and to export the created monitoring screens.

Exporting

To export, click Export on the Toolbar. When

the window for making export settings

appears, f irst, among all the created

monitoring screens, place a check at

"Monitoring screens to export" to select the

monitoring screens to be exported.

When MV Station starts up, the f irst

monitoring screen that opens is called the

Start Screen. To set the Start Screen, from

among the monitoring screens that have

been checked, select the monitoring screen

you want to be the Start Screen by clicking

on that monitoring screen’s name, then click

on the "Selected monitoring screen" button.

To change a setting after it has been made,

click the Clear button and redo the setting.

Exporting
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Click Export to complete the export process. MV

Station will now be able to access the MV Data

folder so that you can view the created monitoring

screens.

3
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Setting Operation Restrictions

First make sure a main video pattern has

been set for the monitoring screen being

specified as the "Start screen". (Check this

by clicking the Settings button under the

Video Pattern tab on p. 106.)

In the window where export settings are

made, select the monitoring screen and

specify the start screen by clicking "Selected

monitoring screen".

When "Enable operation restriction" is

selected, the "Password setting" dialog box

appears. Enter a password and click OK.

Operation Restriction

Operation restriction is a function that places restrictions on the operation of MV Station (such as switching

the start screen to another monitoring screen, camera control, camera Drag & Drop). Operation restrictions

are set by setting a password for MV Data to be exported. When MV Station reads MV Data, the operation

restrictions are automatically enabled if a password has been set for that MV Data. To cancel operation

restrictions, in MV Station re-enter the password that was set in MV Manager.

From the MV Station Tools menu, choose

Option, then in the window that appears,

click on the "Operation restriction" tab. When

operation restriction is enabled, click the

Disable button, then enter the password to

cancel the restriction. If the operation

restriction is disabled, they can be enabled

by clicking Enable.

Canceling Operation Restrictions

Only the items below are enabled in the MV Station menus:

• File menu: "Specify MV Data Folder", "Reload MV Data" "Exit"

• View menu: All items

• Tools menu: "Option ([Operation restriction] tab only)"

• Help menu



Chapter 5

Monitoring
Displaying and monitoring images with the WebView Livescope MV
Station.
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Starting up MV Station

MV Station will display registered monitoring screens. To start up MV Station, double-click the desktop icon

or click the Start button and choose MV Station from the Programs menu.

Screen Configuration

Starting up from the Start menu

"Viewer"

A camera image is displayed.

"Menu" "Toolbar"

Menu

"Camera Source Window"

Shows camera servers, cam-
eras, extarnal device input/out-
put and motion detection (for
VB150 only). Dragging and
dropping enables cameras to
be allocated to the viewer win-
d o w  a n d  c a m e r a s  t o  b e
switched.

Starting up from the desktop icon

"Camera Control Panel"

Cameras can be controlled us-
ing panorama pictures and but-
tons.

File
"Open Monitoring Screen"
Opens monitoring screens that have been exported to a MV Data folder.
"Specify MV Data Folder"
Specifies MV Data folder.
"Reload MV Data"
Reloads the MV Data to reflect the latest data.
"Properties"
Displays properties of the selected monitoring screen.
"Exit"
Exits MV Station.
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View
"Toolbar"
Shows or hides the Toolbar.
"Hide Camera Source Window"
Hides the camera source window if it is displayed when the type of
monitoring screen is Separated Window A or B.
"Camera List"
Switches the camera source window to show camera list.
"Camera Tree"
Switches the camera source window to show camera tree.
"Camera Map"
Switches the camera source window to show camera map.
"Camera Control Panel"
Switches the camera control panel display type (see p. 57).

Viewer
"Camera Control Right"
Acquires right of control over the selected viewer.
"Reconnect"
Reconnects the selected viewer.
"Release Selection"
Cancels the viewer selection.
"Delete"
Deletes the image on the selected viewer.
"Delete (All Viewers)"
Deletes images displayed on all active viewers.
"Snapshot"
Takes a snapshot of the selected viewer.
"Pause"
Pauses the image on the selected viewer and displays a still picture.
"Resume"
Restarts a paused image.
"Full Screen"
Displays the image on the selected viewer on full screen.
"Network Information"
Displays network information on the selected viewer.
"Auto Preset Tour"
Toggles Auto Preset Tour on/off on cameras of the selected viewer.
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Toolbar

"Auto Switch"
Toggles Auto Switch on/off.
"Auto Preset Tour (All Viewers)"
Toggles Auto Preset Tour on/off on cameras of all viewers that are
displaying.
"View Ext-Device Input Log"
Shows external device input history log.
"View Recorded Pictures"
Starts up VBImageBrowser.
"Camera Control Right"
Acquires right of control over the selected viewer.
"Reconnect"
Reconnects the selected viewer.
"Delete"
Deletes the image on the selected viewer.
"Delete (All Viewers)"
Deletes images displayed on all active viewers.
"Snapshot"
Takes a snapshot of the selected viewer.
"Pause/Resume"
Pauses and restarts the image on the selected viewer.
 "Full Screen"
Displays the image on the selected viewer on full screen.
"Network Information"
Displays network information on the selected viewer.
"Ext-Device Output Control"
Controls external device output.
"Camera Control Panel"
Switches the camera control panel display type.
"Auto Preset Tour"
Toggles Auto Preset Tour on/off on cameras of the selected viewer.

Tools
"Auto Switch"
Toggles Auto Switch on/off.
"Auto Preset Tour (All Viewers)"
Toggles Auto Preset Tour on/off on cameras of all viewers that are
displaying.
"Ext-Device Output Control"
Controls external device output.
"View Ext-Device Input Log"
Shows external device input history log.
"View Recorded Pictures"
Starts up the VBImageBrowser.
"Option"
Displays MV Station information and makes network settings.
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Monitoring screens are available with the camera source window, viewer and camera control panel

united or separated. The method of operation is the same in each case.

Type of Screen

Example of united type

Example of a type with camera source window separated

Example of all separated type

Starting up MV Station
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Operating the Monitoring Screen

Opening the Monitoring Screen

For monitoring with MV Station, open the

monitoring screen by accessing a MV Data

folder that has been exported by MV

Manager.

When MV Station is started up, first a dialog

box will open for specifying a MV Data folder.

Once a MV Data folder is accessed and the

monitoring screen has been opened, for

access to another MV Data folder, select

Specify MV Data Folder from the File menu.

Enter the MV Data folder path directly or

click the Browse button, specify a folder and

click OK to open the monitoring screen.

1

2 If the monitoring screen has been specified

beforehand as the Start Screen, the

spec i f ied  screen w i l l  be  d isp layed

automatically. Otherwise, select the screen

you wish to see from the Select Monitorting

Screen dialog box.

Click to select and click OK. With the screen

selected, click the Properties button to

enable the monitoring screen properties to

be referenced.

While a certain monitoring screen is being

displayed, to switch to another monitoring

screen that is in the same MV Data, open it

in the same way from Open Monitoring

Screen.
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Allocating a Camera

Cameras can be freely allocated to viewers.

From the cameras shown on the camera

source window, drag the icon of the camera

you wish to allocate and drop it on the viewer

where you wish it to be shown. If you drop it

on a viewer that is already displaying an

image, the image will be switched to that of

the dropped camera.

If the camera source window has a camera

server icon on the camera map, you can

click the icon to display the names of the

cameras connected to that camera server

and then drag and drop the camera name.

Deleting an Image

To delete the image of a camera that has

been allocated to a viewer, select by clicking

the viewer to be deleted, click Delete on the

Toolbar or select Delete from the Viewer

menu.

To delete the camera images of all viewers,

click "Delete (All Viewers)" on the Toolbar or

select "Delete (All Viewers)" from the Viewer

menu.
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Reloading MV Data Again

If the monitoring screen was changed in MV

Manager while the monitoring screen was

open, the change can be reflected on the

screen by reloading the monitoring screen

data.

Select Reload MV Data from the File menu.

If you wish to update the currently selected

monitoring screen with the latest information,

open the monitoring screen again from Open

Monitoring Screen.

Switching Camera Source Windows

Camera source window display details can

be switched to show camera list, camera tree

and camera map.

Select Camera List, Camera Tree and

Camera Map from the View menu.

If the monitoring screen is a Separated

Window A or B, and the camera source

window is being displayed, you can hide it by

selecting Hide Camera Source Window from

the View menu. If the camera source window

is hidden and you wish to show it, you can

show it by selecting any one of Camera List,

Camera Tree and Camera Map.

"Camera List" "Camera Tree" "Camera Map"

e
Tip

To change the viewer allocation, you can drag and drop from viewer to

viewer. The cameras of the dragged viewer will be allocated to the dropped

viewer and the cameras that had been allocated to the dropped viewer will be

allocated to the dragged viewer.

Also, when dragging and dropping from a viewer to the camera source

window, the cameras that had been allocated to the viewer can be deleted.

Note that you must first release the viewer selection before you change the

viewer allocation.
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Operating the Monitoring Screen

Displaying and Switching the Camera Control Panel

If the monitoring screen is a Separated

Window A or B, the camera control panel

display content can be switched between

Full Size (Horizontal), Full Size (Vertical),

Panorama Only and Control Buttons Only.

Select any one of Full Size (Horizontal), Full

Size (Vertical), Panorama Only or Control

Buttons Only from Camera Control Panel on

the View menu.

Also, when the camera control panel is being

displayed, you can hide it by selecting Hide

from Camera Control Panel on the View

menu. If the camera control panel is hidden

and you wish to show it, you can show it by

selecting any one of Full Size (Horizontal),

Full Size (Vertical), Panorama Only or

Control Buttons Only.

"Full Size (Horizontal)"

"Full Size (Vertical)"

"Panorama Only" "Control  Buttons Only"
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Operating a Camera

Select a Camera to be Operated

To operate a camera, the camera to be

operated must have first been selected. To

select a camera, click the icon of the camera

you wish to operate in the camera source

window or click the viewer that is showing the

image from the camera you wish to operate.

Camera that can be operated include

camera whose icon in the camera source

window has a yellow background, and the

viewer showing image from the camera that

can be operated has a yellow frame.

However, if an icon showing camera-with-

scope (see p.44) is allocated in the camera

source window, the scope turns yellow.

Viewers have a Video Indicator. The indicator

flashes green when a video is being displayed

and illuminates light blue when a still picture is

being displayed.

Operating a Camera with Control Buttons

Zoom button
Lets you zoom in or zoom out. Zoom occurs when the button is held
down and stops when it is released.

AF/MF button
Displays a dialog box for switching between Auto Focus and Manual Focus.

Speed button
Displays a dialog box for camera operation speed.

Backlight Compensation button
Turns backlight compensation on and off. Backlight compensation is
effective when an image is dark due to backlight.

Pan & Tilt/Home buttons
Pan and Tilt movements occur in the direction of the arrows on the
buttons. Operation occurs when the button is held down and stops when
it is released. The center button is the Home button which, when clicked,
returns the camera to its home position.

The camera can be controlled freely with pan, tilt and zoom button operations. Backlight compensation

works when the Backlight Compensation button is on. Click the button again to turn off this feature.

Preset Selection box
Lets you move a camera by selecting a registered presets.

e
Note
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Operating the Monitoring Screen

The Focus dialog box appears when the AF/MF

button is clicked.

"Auto" is auto focus, "Auto (for domes)" is for the

camera used in combination with a camera dome so

that auto focus does not focus on the camera dome

wall surface, and "Fixed at infinity" enables focusing

on infinity. Under Manual focus, the focus can be

adjusted by holding down the Far or Near buttons.

The Speed dialog box appears when the Speed

button is clicked.

For the camera’s "Pan/Tilt Speed", select pan and

tilt speeds as Fast, Normal or Slow.

For the camera’s "Zoom Speed", select camera

zoom speed as Fast or Slow.

If the NU-700 with WV-TCP connection (see p. 99)

is being used, you can set the manual focus speed

to Fast or Slow for the camera's "Focus Speed".

"Pan/Tilt Speed" and "Zoom Speed" settings are

only effective for pan, tilt and zoom operations with

control buttons and for the arrow button operations

on the viewer (see p. 60 "Tip")

Operating the Camera with Panorama

The pan, tilt, and zoom of a camera can be freely controlled from the Panorama window. The

frame displayed on the panorama indicates the portion that displays the image. You can change

the pan and tilt by dragging this frame, and you can zoom in or out by dragging any side of the

frame to make it smaller or larger. Also, by clicking on the Panorama, the camera can be oriented

to make that position the center of the image, and you can create a new frame by dragging on the

Panorama outside the existing frame.

Drag the side of the frame for zoom.

Drag the frame for pan and tilt.

Click on Panorama to make that position the center,

drag to create a frame.

A panorama picture must first be created using the Panorama Creation Tool

supplied with the camera server before you use this feature.
c
Note

If you are using the NU-700 (outdoor camera), use the Admin Viewer supplied with

the VB150 to specify the wiper, exposure and ND filter settings.
c
Note
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Camera pan and tilt can also be freely controlled with the viewer. By clicking the viewer image,

the camera can be oriented to make that position the center of the image.

Click on the viewer to make that position the center

e
Tip

There are another settings to enable pan, tilt and zoom operations with the viewer.

With the viewer selected, choose Properties from the File menu and check the

"Control a camera with arrow buttons" radio button under Camera Control. Set

the mouse cursor over the viewer. There are eight arrows, such as the up arrow at

the top of the screen and the down arrow at the bottom of the screen, for making

changes with the mouse cursor. There are also two central buttons, plus on the

left and minus on the right, for making changes with the mouse cursor. In each

case click and hold to enable pan, tilt and zoom operations.

c
Note

If there is an icon showing camera-with-scope in the camera source window, the

scope will change to match the variations in camera pan and zoom as the camera

is operated.

Operating the Camera with the Viewer

Orientation of the icon changes

to match pan changes

Scope length vary in accordance

with zoom changes
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Operating the Monitoring Screen

Full Screen Display

With the viewer selected, click Full Screen

on the Toolbar to enlarge the viewer display

to fill the screen.

Press "ESC" to return to the original display.

Video Pause/Resume

With the viewer selected, click Pause/

Resume on the Toolbar to pause a video and

enable a still picture to be displayed.

Click Pause/Resume again to return from the

still picture to the video display.

Taking a Snapshot

With the viewer selected, click Snapshot on

the Toolbar to enable the video being

displayed at the time of the click to be saved

to a file as a still picture.

Snapshots can be saved in a JPEG format

file. When the snapshot is taken a dialog box

will appear to enable the location of the file to

be specified. Enter the file name then press

Save.
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Operating the Monitoring Screen

To Reconnect

If the camera server connection has been

cut, you can try to reconnect by clicking the

Reconnect button on the Toolbar.

Viewing Network Information

You can view various items of network

information. To display them, click Network

Information on the Toolbar.

● Frame rate

Shows the frame rate for the viewer.

● Image size

Shows the size of the image being displayed.

● Video capture size

Shows the size of the video being captured by

the camera server.

● Compression type

Shows the image compression type being used.

● Video [WV-TCP]

Shows the IP address and Port No. of the camera

server if WV-TCP is being used for the video

transmission protocol.

● Camera control [WV-TCP]

Shows the IP address and Port No. of the camera

server if WV-TCP is being used for the camera

control protocol.

● Video/Camera control [WV-HTTP]

Shows the IP address and Port No. of the camera

server if WV-HTTP is being used for the protocol.

● HTTP proxy

Shows whether a HTTP proxy in being used

(ON) or not used (OFF).

● Local time

Shows the current time at the camera server.



Chapter 6
Managing the Camera Servers

This chapter describes how to use WebView Livescope MV Manager to
manage the camera servers such as making camera server settings or
upgrading the firmware.
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Setting and Managing Camera Servers

In MV Manager, select a registered camera

server icon by clicking on it. When you click

on the Open Setup Page button on the

Toolbar, the browser starts up and accesses

the camera server.

The settings title page appears.

From the browser you can make detailed

settings for the camera server, settings for

recording still pictures, and other settings.

For details on making camera server

settings, see Chapter 3 of the camera server

manual.

Comprehensive management of registered camera servers is possible with MV Manager. Operations such

as changing camera server settings, confirming images, and upgrading the firmware in all cameras at once

can be performed remotely.

Testing Camera Server Images

Select a registered camera server icon

by clicking on it. When you click on the

View Test button on the Toolbar, the

window appears where you can check

and confirm camera operation and

images.

e
Tip

1

2

This example shows the VB150 settings page.
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In MV Manager, select a registered camera

server icon by clicking on it. You can

remotely upgrade the selected camera

server to the latest version by choosing

Upgrade Firmware from the Tools menu.

The firmware for multiple camera servers

can be upgraded simultaneously by selecting

multiple camera server icons.

Upgrading the Firmware

When you choose Upgrade Firmware, a

dialog box appears where you select the

firmware file to be transferred to the camera

server. Either enter the path directly or click

Browse to select the file.

File transfer starts when you click Next.

To upgrade the firmware, you first need to obtain the new firmware. For the latest information on

the new firmware, see the Web site below:

http://www.canon.com/webview/

1

2

c
Note

● When upgrading the VB101, be sure to use FTP and back up the camera

server file system first.

● The VB-C10/VB-C10R and VB150 cannot be upgraded from MV Manager.

The firmware file is transferred and stored in

the Flash ROM. The results are then

displayed. Click Close to complete.
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Chapter 7

Advanced Operations
This section explains advanced operations of WebView Livescope MV
Ver. 2.1, such as viewing recorded pictures and automatic operations.
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Setting an Auto Preset Tour

For Auto Preset Tour, the positions that are
to be toured, the sequence in which they will
be toured, and the pausing span at each
position, may be set freely. On the MV
Manager’s Camera Servers screen, select by
clicking the camera server icon of the
camera for which you wish to set Auto Preset
Tour, then click the Properties button on the
Toolbar.

Click the Setup Auto Preset Tour button on
the Camera tab of the camera you wish to
set on the window that was displayed.

1

Automatic camera operations are possible with MV Station. The three types of automatic camera

operations are: Auto Preset Tour, Auto Switch and Video Relay, each of which can be operated

independently or in combination. With appropriate settings, automatic camera operation can enable

effective monitoring.

Automatic Operation Functions of MV Station

Auto Preset Tour
Auto Preset Tour is a sequential tour of a
previously established preset position by one
camera. At the established preset position it
can be stopped only at a specified time. This
saves the work of operating a camera
periodically at a monitoring point.
MV Manager makes Auto Preset Tour
settings for each camera. By switching Auto
Preset Tour on, MV Manager implements the
tour in accordance with those settings.

Moving the preset

position of the camera

c
Note

Auto Preset Tour can be implemented only by viewers with MV Level or MV

Level 2 control privilege. It is not available at Free Viewer Level (see p. 105).

Viewer 1

(Camera 1)

Preset 3

Viewer 1

(Camera 1)

Preset 1

Viewer 1

(Camera 1)

Preset 2
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2 The Auto Preset Tour Settings dialog box

shows a list of presets registered in the

Presets. Select by clicking the preset name

you wish to use for Auto Preset Tour, then

click "Add to Schedule" and it will be added

to the Tour Schedule field. If you wish to

delete an added preset name, select by

clicking the preset name in the Tour

Schedule field, then click Delete. To delete

all names, click Delete All.

When the preset names you wish to use for

Auto Preset Tour have been added to the

Tour Schedule, select by clicking a preset

name in the Tour Schedule field and use the

Up and Down buttons to switch the

sequence for making the tours. Tours will be

made in sequence from the preset that

appears at the top.

No Auto Preset Tour has been set

e
Tip

Viewers have an "Auto Preset Tour Indicator" that indicates the status of

Auto Preset Tour.

Auto Preset Tour is set but is not in
progress (gray display)

Auto Preset Tour in progress (colored
display)

3 Having selected by clicking preset names in

the Tour Schedule field, you can change the

numbers in the Pause Span box. Pausing

span can be set in five-second increments

between 5 and 120 seconds.

When the setting is completed, click the

Export button on the Toolbar to export the

MV Data and reload it in MV station.

c
Note

The preset settings need to be made before using the Auto Preset Tour

function. Note that the preset used in Auto Preset Tour is specified on MV

Manager and that it is different from the preset on the camera server side

(see p. 100).
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Auto Switch

Auto Switch is used for switching the

sequence for displaying images from the

cameras of the viewer previously specified in

the monitoring screen properties. Setting

Auto Switch switches the connections to the

specified camera server’s cameras and

displays images in the registered video

pattern. At that time, the operations at the

preset positions can proceed at the specified

switching intervals. If there are more

cameras than monitoring screens, several

camera servers can be monitored efficiently.

MV Manager makes Auto Switch settings for

each monitoring screen. By turning Auto

Swi tch  on,  MV Sta t ion  implements

operations in accordance with those settings.

c
Note

A slight time difference may occur between the actual pause span and the

time that was set.

Viewer 1

(Camera Server 1)

Preset 1

Viewer 2

(Camera Server 2)

Preset 2

Viewer 1

(Camera Server 3)

Preset 3

Viewer 2

(Camera Server 4)

Preset 4

Changing camera and preset that are displayed

● Starting up Auto Preset Tour
To start up Auto Preset Tour, select by
clicking the viewer that is displaying the
image of the camera you wish to use for
touring and then click the Auto Preset Tour
button on the Toolbar.

● Stopping Auto Preset Tour
If you wish to stop Auto Preset Tour, select
by clicking the viewer that is displaying the
image of the camera you wish to stop
touring and then again click the Auto
Preset Tour button on the Toolbar.

● Auto Preset Tour for Several Cameras

Auto Preset Tours with several cameras

can also be conducted at the same time.

Moreover, when you click the Auto Preset

Tour (All Viewers) button on the Toolbar,

Auto Preset Tour can be applied to

displayed images of all cameras set with

Auto Preset Tour.

Starting/Stopping Auto Preset Tour
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Automatic Operation Functions of MV Station

The Auto Switch dialog box shows a list of

registered cameras that are assignable in

Assignable Cameras. Select by clicking the

names of the cameras you wish to assign

then click Assign and they will be added to

the "Assignment to viewers".

If the names of the cameras you wish to

assign have all been assigned, select by

clicking camera names in the "Assignment to

viewers" and use the Up and Down buttons

to arrange them in the viewer where you

wish to display them. The viewer for the

number shown in "Viewer arrangement

preview" corresponds to the number in the

"Assignment to viewers" field.

Auto Switch Settings

The assignment of cameras to a viewer, their

switching sequence, preset display positions

and switching intervals, can each be set

freely with Auto Switch. With MV Manager’s

Monitoring Screens, select by clicking the

icon of the monitoring screen that you wish

to use for setting Auto Switch, then click

Properties on the Toolbar.

Click New button in the Auto Switch field on

the Video Pattern tab of the window that is

displayed.

1

2
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3 When switching to assigned camera display,

cameras can be moved to previously

registered preset positions. Select by clicking

camera names in the "Assignment to

viewers" field and select the names of the

presets you wish to display from the Preset

box.

Assign a name to the assigned video pattern.

Enter the name in the "Video pattern name"

box and click OK.

If you are switching a sequence of multiple

video patterns, repeat the above procedures.

Select by clicking video pattern names

shown in the "Order of Auto Switch" field and

use the Up and Down buttons to switch the

sequence of operations. Tour starts from the

top.

●  Starting up Auto Switch

To operate Auto Switch, click the Auto

Switch button on the Toolbar.

●  Stopping Auto Switch

If you wish to stop Auto Switch, click the

Auto Switch button on the Toolbar again.

c
Note

The preset settings need to be made before using the Auto Switch function.

Note that the preset used in Auto Switch is specified on MV Manager and that

it is different from the preset on the camera server side (see p. 100).

Starting/Stopping Auto Switch

The switching interval can be varied freely by changing the numerical value in the Interval box.

Settings can be made in one-second intervals between 10 and 180 seconds.

When the setting is completed, click the Export button on the Toolbar to export the MV Data

and reload it in MV station.
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Automatic Operation Functions of MV Station

Video Relay

Video Relay is used for sequential ly

switching the video displays from several

cameras connected to one camera server.

For viewer display, since only one of several

viewers can be displayed in video, automatic

sequential switching saves the monitoring

work involved in switching the video displays

by clicking the viewers one by one.

Setting Video Relay Intervals

Video Relay lets you freely set intervals for

switching video displays.

Select Properties from File in MV Station.

Alter the number in Interval under Video

Relay on the General tab in the window that

is displayed. You can set an interval between

5 and 30 seconds in increments of one

second.

After you have made the setting, click OK or

Apply.

1

2

c
Note

● Video Relay cannot be used with the VB-C10/VB-C10R and the VB150 with

the Video Input set to Multiple.

● Some of the features of the Video Relay may be unavailable if the motion

detection is enabled on the VB150 (see p. 105).

Viewer 1

(Camera 1)

Viewer 2

(Camera 2)

Viewer 3

(Camera 3)

Viewer 4

(Camera 4)

Video display sequentially switched
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●  Starting up Video Relay
Video Relay works automatically in a

s i tua t ion  where  severa l  cameras

connected to one camera server are being

shown on v iewers.  The swi tch ing

sequence for the video display is viewer ID

order.

●  Stop/Resume Video Relay

If you wish to stop Video Relay, select one

of the viewers connected to the camera

server by clicking. To replay the Video

Relay, click a location outside the viewers

in the viewer display area or cancel the

selection by selecting Release Selection

on the Viewer menu.

Starting/Stopping Video Relay
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Monitors two 
places for 10 
seconds each 

with video 
display

D
C

B

A
VC-C4COMMUNICATION CAMERA

f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

Monitors 
four places for 

10 seconds each 
with video 

display

Monitors a 
fixed location for 

30 seconds 
with video 

display

Monitors a 
fixed location 
for 30 seconds 

with video 
display

START

Auto Preset Tour

Auto Preset Tour set 
for 20-second cycles

Auto Preset Tour set 
for 40-second cycles

(video display)

30 
seconds

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

VC-C4
COMMUNICATION CAMERA

f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

20 
seconds

70 
seconds

60 
seconds

100 
seconds

130 
seconds

Video Relay

Video Relay

D

C

B

A

Even if the Auto 
Preset Tour's 20-
second cycle is 
exceeded, since the 
Video Relay interval 
is 30 seconds, the 
Auto Preset Tour 
continues 
undisturbed. 

Even if the Video 
Relay's 30-second 
interval is exceeded, 
the Auto Preset Tour 
continues until its 
40-second cycle 
ends. 

Auto Preset Tour
(video display)

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

VC-C4
COMMUNICATION CAMERA

f:4-64mm 1:1.4-2.8

By operating Auto Preset Tour in combination with Video Relay, the preset tour set for several
cameras can be effectively displayed in video.

Let us look at an example of monitoring by four
cameras connected to one camera server.
Since there are a number of places that you
wish to check, Cameras A and B are set up for
an Auto Preset Tour. Cameras C and D are
periodically observing fixed points with Video
Relay.
● Camera A is set for a 20-second Auto

Preset Tour for 10-second cycles for each of
two places.

● Camera B is set for a 40-second Auto
Preset Tour for 10-second cycles for each of
four places.

● The Video Relay interval is set at 30
seconds and the sequence is A, B, C, D.

First, A starts an Auto Preset Tour. The Auto Preset Tour continues until the Video Relay is switched

to B after 30 seconds and, at the time it is switched, the Auto Preset Tour (the second tour) is

stopped.

Next, B starts an Auto Preset Tour. Since B’s Auto Preset Tour cycle is 40 seconds, 30 seconds of

Video Relay is ignored while the Auto Preset Tour continues for 40 seconds.

When B ends one cycle of Auto Preset Tour, C is displayed in video by Video Relay. C’s 30-second

video display start from the time when this is switched. Then switches to D and 30 seconds later, it

returns to the initial cycle.

● If the Auto Preset Tour cycle is longer than the Video Relay interval, the Auto Preset Tour cycle

will be continued until it has made one cycle.

Automatic Operation Functions of MV Station

Examples of Using Automatic Operation

Auto Preset Tour Combined with Video Relay
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c
Note

Auto Preset Tour and Auto Switch cannot be operated at the same time.

D
Camera 
Server 1

C

B

A
VC-C4COMMUNICATION CAMERA

f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

H
Camera 
Server 2

G

F

E
VC-C4COMMUNICATION CAMERA

f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

Monitors a 
fixed location 

for 5 seconds with 
video display

Monitors a 
fixed location for 
5 seconds with 
video display

Monitors a 
fixed location 
for 5 seconds 

with video 
display

Monitors a 
fixed location 
for 5 seconds 

with video 
display

Monitors a 
fixed location for 
10 seconds with 

video display

Monitors a 
fixed location for 
10 seconds with 

video display

Monitors a 
fixed location 

with video 
display Monitors a 

fixed location with 
video display

START

Camera Server 1

30 seconds 50 seconds

Video Relay Video Relay

Video Relay is repeated 
each 5 seconds until 
switched by Auto Switch 
after 30 seconds

A B

CD

E F

GH

Camera Server 2

Since Auto Switch 
occurs at 20 seconds, 
Video Relay is up to E 
and F but the still 
pictures of G and H are 
updated with the latest 
image when Auto 
Switch occurs.

Auto Switch Combined with Video Relay

By Operating Auto Switch in combination with Video Relay, you can effectively switch cameras
assigned to viewers that are set on several camera servers and display video.

Let us look at an example of two camera servers, each of which has four cameras connected for
monitoring by Video Relay while cameras assigned to viewers are being switched. Camera Server
1 has Cameras A, B, C and D, while Camera Server 2 has Cameras E, F, G and H, each
assigned to four viewers switched by Auto Switch.
Video Relay is set up for A to F to sequentially display video but G and H may monitor with still
pictures.
● The Video Relay interval for Camera Server 1 is set to five seconds and the sequence is A, B,

C, D.
● The Video Relay interval for Camera Server 2 is set to ten seconds and the sequence is E, F,

G, H.
● The Auto Switch intervals are set to 30 seconds for A to D and to 20 seconds for E to H.

First, Video Relay is
r e p e a t e d  i n  t h e
sequence A to D during
the 30-second interval.
After 30 seconds, it
switches to the E to H
video pattern but since
the  in te rva l  i s  20
seconds, G and H do
not  d isp lay  v ideo .
However, G and H are
updated to the latest
image when the video
pattern is switched.
● The still pictures of

Video Relay cameras
are all updated when
the video pattern is
switched.
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Automatic Operation Functions of MV Station

e
Tip

If the VB150 is being used, you can either select Single or Multiple for the

Video Input setting.

VB150

If Single is selected when more than one camera is connected to the VB150,

only the controllable camera's image can be displayed in video on MV

Station. If Multiple is selected, multiple camera video images can be

displayed at the same time on MV Station. However, multiple cameras

cannot be controlled at the same time.

In Multiple mode, the video indicators of all viewers

displaying images flash green, which indicates that

the video is being displayed.

Single or Multiple can be selected on the VB150 settings page (VB150 User's

Manual p.40).

VB150 Settings Page
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ONOFF

External Devices Input/Output

Notification of External Device Input

Actions such as the following can be specified to notify you on a screen being monitored by MV

Station that input from an external device has occurred:

Select Camera 1 as the camera shooting the image 
when notification of an event is received.

Camera4Camera3

Camera2

Camera1

Title flashes

Camera 1 image is

being displayed

• When input from the camera
server has been notified while
image is being displayed, the
ti t le of the viewer can be
caused to f lash when the
corresponding camera image is
being displayed.

Camera 1 image is

not being displayed

Camera 1 image is

allocated and the

title flashes

• When the cor respond ing
camera image is not being
displayed, the viewer can
automat ical ly  d isplay the
camera image and the viewer
title can be flashed.

• When input from the camera
server that is not displaying
image has been notified, the
corresponding camera image
can be allocated and displayed.

• If an input notification occurs to
one of the viewers relaying
videos, Video Relay will stop
and the viewer that was notified
will show video.

The settings are made in Camera Server

Properties of MV Manager (see p.101).
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• You can switch the direct external device

output terminals on/off with the Output ON

and Output OFF buttons.

Clicking Ext-Device Output Control on the MV Station Toolbar will let you directly control external

device output.

External Device Output Control

• External device input icon

displayed on the camera tree,

camera list or camera map

changes  when  an  i npu t

notification is received.

• A sound can be generated

when external device input has

been notified (see p. 107).

External device input notification settings are made in Camera Server Properties of MV Manager

(see p. 101) and Monitoring Screen Properties of MV Station (see p. 107).

c
Note

If a camera registered on the screen was restarted while monitoring in MV Station was

in progress, the screen needs to be selected again. If this is not done, the notification of

input events from external devices will no longer occur.
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Motion Detection

Notification of Motion Detection

If the VB150 is being used, actions such as the following can be specified to notify you on a screen

being monitored by MV Station that motion has detected.

Title flashes

Camera 1 image is

being displayed

• When motion detection event
from the camera server has
been notified while image is
being displayed, the title of the
viewer can be caused to flash
when the  cor respond ing
c a m e r a  i m a g e  i s  b e i n g
displayed.

Camera 1 image is

not being displayed

Camera 1 image is

allocated and the

title flashes

• When the cor respond ing
camera image is not being
displayed, the viewer can
automat ical ly  d isplay the
camera image and the viewer
title can be flashed.

• When motion detection event
from the camera server that is
not displaying image has been
notified, the corresponding
camera image can be allocated
and displayed.

VB150

Use the Motion Detection

Setting Tool provided with

the VB150 to set the motion

detection function of the

VB150 and specify on the MV

Station to receive motion de-

tection events.

● Notification of motion detection in the Camera 1 image

● Notification of motion detection in the Camera 1 image

Motion Detection Setting Tool Screen

The settings are made in Camera

Server Properties of MV Manager

(see p.102).
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• Motion detection icon displayed

on the camera tree or camera

l ist changes when motion

de tec t i on  no t i f i ca t i on  i s

received.

• A sound can be generated

when motion detection has

been notified (see p. 108).

Motion detection notification settings are made in Camera Server Properties of MV Manager (see p.

102) and Monitoring Screen Properties of MV Station (see. p. 108).

c
Note

If a camera registered on the screen was restarted while monitoring in MV Station was

in progress, the screen needs to be selected again. If this is not done, the notification of

motion detection event will no longer occur.

Notification of motion detection while Video Relay is in progress

If you receive notification of motion detection while Video Relay is in progress,
actions vary depending on the Camera Control Right settings.

If the "Display the corresponding video
when motion detection is enabled" box
is not selected (see p. 104), the camera
in which the motion was detected
displays the video. As other viewers
cannot obtain the camera control
privileges, the display either stays as a
still picture, or nothing is displayed.
This is because the motion detection
obtains the camera control privileges
at a higher priority level than MV Level
(see p. 105).

Camera 1 image be-

comes video display

and the title flashes

C a m e r a  c o n t r o l

privileges cannot be

obtained with other

viewers

● Notification of motion detection in the

Camera 1 image
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If the "Display the corresponding video

when motion detection is enabled" box

is selected, all viewers display the

video from the camera that detected

the motion.

Camera 1 image be-

comes video display

and the title flashes

Other viewer also

displays the Camera

1 image in video

● Notification of motion detection in the

Camera 1 image
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Motion Detection

To switch the camera control level to MV
Level 2, right-click on the viewer and select
"MV Level 2 Control Right" from the menu.

Motion detection cannot be notified while
camera control privileges are being obtained
with MV Level 2 because motion detection
cannot obtain camera control privileges. To
receive motion detection notification again,
select "Revert to MV Level Control Right" to
return the control level to MV Level.

The Free Viewer Level selected in the
monitoring screen cannot be changed to MV
Level or MV Level 2 in the MV station.

Notification of Motion Detection and Camera Control

As the motion detection obtains the camera control privileges at a higher priority level than MV

Level (see p. 105), if motion is detected and video is displayed in the viewer from the camera that

detected the motion, you cannot control the camera (only while motion is detected). If you want to

control the camera while motion is detected, changing the level control right to MV Level 2 allows

you to obtain the camera control privileges.

c
Note

Use the Motion Detection Setting Tool provided in the VB Administration Tools to

specify the motion detection schedule, area ratio, sensitivity, etc (see VB150 User's

Manual p. 80).

Caution

[Notes on Using This Function]

The Motion Detection Function is not suited to applications where high levels of

reliability are demanded. Therefore, we recommend that you not use this function for

monitoring or other purposes if consistently high levels of reliability are required. Canon

accepts no liability whatsoever for faults, etc. resulting from the use of the Motion

Detection Function.
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Recording and Viewing Pictures

Camera servers have functions for recording pictures (still pictures) that are switched on/off by input/output

from external devices and are based on motion detection and previously established schedules. The

recorded pictures can be managed and automatically downloaded or downloaded, searched and displayed

by MV Station.

The Settings Title Page will be displayed.

Settings for recording schedules and

recording pictures in respose to external

device (such as sensors) are to be made on

the "Picture Recording and External Device

I/O" Settings Page.

Picture Recording Settings

c
Note

Picture recording functions are camera server functions. For details of

functions and settings, see "Using the Picture Recording Function" in the

Camera Server Manual or if the VB150 is being used, see Picture Recording

User's Guide contained in the supplied CD-ROM.

Select by clicking a registered camera server

icon in MV Manager and click Open Setup

Page on the Toolbar to startup the browser

and access the camera server.

1

2

3 Log sett ings are to be made on the

"Miscellaneous" Settings Page in order to

write the external devices input and motion

detection logs to the log file.

The example is the VB150 settings page.
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VBImageBrowser is used as the tool for

managing images and searching and

displaying downloaded recorded pictures.

To start up VBImageBrowser, click the View

Recorded Pictures button on the MV Station

Toolbar.

Using VBImageBrowser

Screen Configuration

"Camera server tree"

Image files downloaded from the camera server are displayed in a tree

according to the camera server and recorded conditions.

"Menu" "Toolbar"

"Thumbnail display area"

Condensed images contained

in the folder selected in the

image folder tree are displayed

here.

"List display area"

Detailed information about the

image contained in the folder

selected in the image folder

tree is listed here.

"Date-setting frame"

This lets you specify the date (of picture recorded) and

limit the range of images to be displayed by the camera

server tree.

"Image folder tree"

Files of images to be managed are classified according to

server and recorded condition and displayed as a tree.
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Menu

Camera Server

"Preview"

Previews the recorded pictures in the server before downloading.

"Download"

Downloads recorded pictures from the selected camera server.

"Display Log"

Downloads the log file from the selected camera server and displays the log.

"Recording Schedule"

Opens the "Picture Recording and External Device I/O" Settings Page by

accessing the selected camera server.

"Exit"

Quits VBImageBrowser.

Image

"Delete"

Deletes selected images.

"Backup"

Lets you take a backup of selected images.

"Import VB image"

A VB image saved in the PC is imported as a camera server image.

"Exif Conversion"

Converts images to Exif format.

"Select All"

Selects all images in a selected folder.

View

"Add Folder"

Adds a folder to Image Folder and Backup on the image folder tree.

"Delete Folder"

Deletes an Image Folder, Backup and Preview folder from the image folder

tree.

"Toolbars/Status Bar"

Shows or hides Toolbar and/or Status Bar.

"Image Folder Tree/Thumbnail Image/Image List"

Shows or hides image folder tree, thumbnail image and/or image list.

"Properties"

Displays detailed information about a selected camera server or images.

"Refresh"

Updates contents of display to the latest information.

Tools

"Search"

Searches the camera server tree for images with specified attributes.

"Sort by Similarity"

Sorts images according to their similarity with a selected image.
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Recording and Viewing Pictures

"Search image"
Searches the camera server tree for images with specified attributes.

"Delete image"
Deletes the selected images.

"Download recorded picture"
Downloads recorded pictures from the selected camera server.

"Sort by similarity"
Sorts images according to their similarity with a selected image.

"Compare 2 continuous images"
Detects a different image in a series of images.

"Refresh"
Updates contents of display to the latest information.

"Toggle image folder tree"
Shows or hides image folder tree.

"Toggle image list"
Shows or hides image list.

"Toggle thumbnail image"
Shows or hides thumbnail images.

"Close all detail display windows"
Closes all windows when detail display windows are displayed.

"Confirm or set picture recording schedule"
Opens the Picture Recording and External Device I/O Settings Page by
accessing the selected camera server.

"Task settings"

Displays VBCollector Task View.

"Image Comparison"

Detects a different image in a series of images.

"VBCollector Task View"

Displays VBCollector Task View.

"Options"

Makes environmental settings.

Window

"Close All"

Closes all windows when detail display windows are displayed.

Toolbar
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Downloading All Recorded Pictures

Select by clicking the camera server you

wish to download from the camera server

tree, then click "Download recorded picture"

on the Toolbar.

Automatic Downloading of Recorded Pictures

Click "Task settings" on the Toolbar to start

up the VBCollector Task View.

Using VBCollector lets you download

recorded p ic tu res  per iod ica l l y  and

automatically. Please refer to "Using

VBCollector" in your camera server manual

for methods of making VBCollector settings.

I f  you cl ick Refresh on the Toolbar,

VBImageBrowser will reflect the images

downloaded automatically by VBCollector.

1

2 The Download dialog box will appear and

downloading will start when you click OK. If you

choose "Delete images on the server", the

pictures you have downloaded will be deleted

from the camera server.

Downloaded images will be added to the

recorded conditions folder that correspords to

the camera server tree.

A PC with this software (WebView Livescope MV Ver.2.1) installed will be

different from one with only VBCollector installed in the following ways:

● There is no Server menu. MV Manager handles Server "Add" and "Edit".

● There is no "Display Images" or "Delete Image" in the Tools menu.

VBImageBrowser handles these items.

● Task display is limited to selected camera server in the VBImageBrowser

camera server tree.

e
Tip
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1

2

c
Note

e
Tip

Recording and Viewing Pictures

Recorded pictures that match these

conditions will be listed when you click OK.

Click the pictures you wish to download from

the list. The selected pictures will start to be

downloaded when you click "Download

recorded picture" in the Toolbar. If several

pictures are to be downloaded, for a series of

pictures hold down the [Shift] key while you

click, or for separate selections hold down

the [Ctrl] key while you click.

In Preview, it is possible only to delete, download, or display details of

recorded pictures selected from the list.

The recorded pictures you select here are in the camera server and are

directly deleted from the server when Delete Recorded Picture is selected on

the list in Preview. Please keep in mind that it is different from the "Delete

image" on the Toolbar which deletes the images that have been downloaded

from the camera server to the PC.

Recorded pictures in the camera server can

be directly viewed (previewed) before

downloading them to the PC. In Preview, it is

also possible to select pictures in a list and

download only those pictures.

Select by clicking the camera server you

wish to download from the camera server

tree then choose Preview from the Camera

Server menu. In the dialog box that appears,

set "Camera", "Trigger" and "Date & Time"

for the recorded pictures you wish to

preview.

Preview (Select recorded pictures and download)
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Displaying Images

"Enlargement/Reduction

control"

Enlargement ratio display

Enlarge by 10%

Reduce by 10%

If the image is larger than

the image display area, it

can be moved by dragging

"Resize button"

For varying the window size.

"Animation control"

Image file is displayed serially.

Show first image

Show previous image

Replay/Pause

Show next image

Show final image

Speed adjust bar

When "Trigger" or "Date & Time", whichever

is the lowest level folder in the camera server

tree under Camera Servers, is opened,

image files contained in that folder will

appear as thumbnails and listings. Also,

when "Search Results/Search Name",

"Image Folder/Folder Name", "Backup/Date",

"VB Card/Time" folders are opened, the

image files contained in those folders will

appear as thumbnails and listings. Double

clicking the thumbnail or listing of an image

file will open as detailed display window,

where you can view the images and detailed

information such as the recording conditions.

"Image information display area"

Detailed information about the image is displayed.

"Image display area"

Image is displayed.
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Image Searching

Select by clicking the folder in the camera

server tree you wish to search, and then click

"Search image" on the Toolbar. Folders to be

searched are folders under Camera Servers

or Search Results.

The Search dialog box will appear when you

click "Search image".

The Search Name you enter will be the

name of the folder to be created and can be

used for management. After you have

specified "Date & Time", "Camera" and

"Trigger", click  OK.

When the search is performed, a folder

named for the Search Name will be created

under Search Results in the image folder

tree.

1

2 Image files that match the

search condit ions wil l  be

collected in the search name

folder that has been created

under the Search Results

folder in the image folder tree.

Specify Display Range

When downloading is performed over a long

period, many "Recorded Date" folders will be

created and the display becomes difficult to see. It

will then be helpful to use "Date-setting frame" to

limit the recorded dates to be shown in the camera

server tree. First, click the Edit button and set the

"between" and "and". Click the Apply button and

then select the "Display all dates" so that the only

images corresponding to the specified range are

displayed in the camera server tree.

e
Tip

Recording and Viewing Pictures
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1

2 "Image comparison control bar" is displayed

on the Toolbar.

Comparison from the selected images

proceeds in the order in which they are

displayed in the list or thumbnails. When

different images are detected, the series of

two images with points of difference become

selected and the comparison stops. If you

wish to make further comparisons, click

Resume on the "image comparison control

bar". Click Stop to stop image comparison

during execution; click Finish to quit image

comparison.

In cases where there seem to be many similar

images, you can check the recorded content

easily by inspecting to search for points where

the image contents have changed.

Select by clicking the folder on the image

folder tree containing the images you wish to

compare and select by clicking the image you

want to compare on the list or in the

thumbnails. The Image Comparison dialog

box appears when you click "Compare 2

continuous images" on the Toolbar. The

image is shown divided into 12 × 9 blocks and

you will select the area to be compared by

dragging on the screen. The selected blocks

are shown in a red frame.

"Comparison Condition" judges whether the

color layout of images are similar or not. Try both

Type A and Type B methods and use the one

that give good results.

"Sensibility of difference" sets levels for

judging different images. The sensitivity

becomes higher as you move the slider

towards "HIGH" and even small differences

are detected.

After setting, click OK.

Comparing Images
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"Image comparison control bar"

"Resume/Stop" executes or stops comparison

"Finish" quits image comparison

"Sensibility of difference" sets detection sensibility for different

images

"Use Default" restores "Sensibility of diffrence" setting to default

value.

Sorting Images in Order of Similarity

Based on a certain image, the list or

thumbnails can be rearranged in the order of

their similarity to that image.

Select by clicking the folder on the image

folder tree containing the images you wish to

compare and select by clicking the image

you want to compare on the list or in the

thumbnails. The "Sort by Similarity" dialog

box appears when you click "Sort by

similarity" on the Toolbar. The image is

shown divided into 12 × 9 blocks and you will

select the area to be compared by dragging

on the screen. The selected blocks are

shown in a red frame.

 "Comparison Condition" judges whether the

color layout of images are similar or not.

Try both Type A and Type B methods and

use the one that give good results.

After setting, click OK.

1

2 Image shown on the list and

by thumbnails will be sorted by

similarity.

Recording and Viewing Pictures
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JPEG image files saved in the PC can be

added to the image folder tree by folder units

and viewed.

Choose [Add Folder]-[Image Folder] from the

View menu. Enter the path of a folder to be

added to the image folder tree, or click

Browse to select a folder you wish to add,

then click OK.

When it is executed, the folder will be added

to the image folder tree under Image Folder.

Adding a Folder

Browse the VB Card Folder
Recorded pictures can be imported by

inserting the flash memory card into a PC

card drive. Choose Options from the Tools

menu and set PC Card Drive to the letter

indicating the card drive of your personal

computer. Insert the flash memory card into

the PC card drive, right click VB Card on the

image folder tree and choose Reload from the

pop-up menu. The VB Card folder can be

accessed when Reload is selected.

From the image folder tree, select by clicking a

folder or image file under VB Card then choose

[Import VB image] -  [Name of camera server to

be imported] from the Image menu.

When import is executed, they will be added

to the camera server tree as camera server

images that have been imported.
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VB Images Backing Up

You can make backups of images. Images to

be backed up are images contained in

folders under Camera Servers or Search

Results.

To make backups, first select by clicking the

folders in the camera server tree that you

wish to back up, or select by clicking the

images from the list or thumbnails that you

wish to back up. Next, choose Backup from

the Image menu. Enter the path of the

backup destination folder or select a backup

folder by clicking Browse and then click OK.

When backup is executed, a folder will be

added under Backup in the image folder tree.

A removable media drive can also be

specified as the backup destination.

Import VB Images (Backup)

VB images and backup images saved in the

PC can be imported as camera server

images.

First add a importing folder under Image

Folder or Backup in the image folder tree

(see p. 94 for details on Adding a Folder.).

To import VB images, select by clicking the

folder added to the image folder tree, or

select by clicking the images you wish to

import from the list or thumbnail display.

Then, choose [Import VB images] - [Name of

camera server to be imported] from the

Image menu.

When importing is executed, they will be

added to the camera server tree as camera

server images that have been imported.

Recording and Viewing Pictures
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Displaying Camera Server Information

Camera server information can be displayed.

Select by clicking the camera server in the

camera server tree. Then choose Properties

from the View menu to open the Server

Information dialog box.

Viewing the Log

The camera server log can be downloaded

and viewed.

Select by clicking the camera server on the

camera server tree whose log you wish to

view, and then choose Display Log from the

Camera Server menu.

The Log Viewer will start up. For information

about the contents displayed by the Log

Viewer, please refer to the item on "Log

Viewer" in your Camera Server Manual.

1

2

For the log to be viewed, the camera server settings must include a setting

for writing the log (see p. 84).
e

Tip
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Converts VB images to Exif Format.

Exif is an image file format based on TIFF and JPEG, intended for storing

various items of information for use with digital cameras etc.
e

Tip

Information to be added to Exif tags

"Image resolution in width direction", "Image resolution in height direction", "Unit of X and Y resolution",

"Subsampling ratio of Y to C", "Exif tag", "Exif version",  "Meaning of each component", "Supported

FlashPix version", "Color space information", "Valid image width", "Valid image height", "Manufacturer

of image input equipment", "Model of image input equipment", "Date and time of original data generation",

"Date and time of digital data generation", "Magic Number (identity of recorded picture file)", "Trigger",

"Camera Number", "Pan Angle", "Tilt Angle", "Zoom Value", "Brightness", "Recorded Time", "External

Device Input Conditions", "External Device Output Conditions", "Video Quality"

An image files can be output as an Exif file

by adding an Exif tag.

Select by clicking the folder on the camera

server tree that contains the images you

wish to convert, or select by clicking the

images you wish to convert from the list or

thumbnail display. Choose Exif Conversion

from the Image menu. Enter the path of a

folder to output Exif files, or click Browse to

select an output destination folder, then click

OK.

Recording and Viewing Pictures
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You can start up the "External Device Input Log Viewer" from MV Station to display only the logs of

external device input (see p. 78) events and motion detection (see p. 80) events that have

occurred. You can view the recorded pictures for one minute before and after the time the event

occurred.

External Device Input/Motion Detection and Picture Recording

Examining the External Device Log

The External Device Input Log Viewer will

start up when you click "View Ex-Device

Input Log" on the MV Station Toolbar.

Whereas the Log Viewer (see p. 96) shows

all contents of the log, the External Device

Input Log Viewer shows only the logs of

external device input events and motion

detection events. For information about the

contents displayed by the Log Viewer,

please refer to the item on "Log Viewer" in

your Camera Server Manual.

Displaying Images Before and After an Event

From the log list, double click the log of the

event for which you wish to show the

recorded pictures, or select by clicking the

log, and then choose View Images from the

View menu to have VBImageBrowser show

the recorded pictures for one minute before

and after the event.

For the log to be viewed, the camera server settings must include a setting

for writing the log (see p. 84).
e

Tip

Recording and Viewing Pictures
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MV Manager and its Other Functions and Settings

Other Advanced Settings

Camera Server Properties

Select a camera server and click the Properties button on the Toolbar to display the Properties

dialog box. Properties lets you make detailed camera server settings.

• You can select and alter the connection protocol from WV-TCP, WV-HTTP and Auto-Select.

Auto-Select is initially connects by WV-TCP and connects by WV-HTTP if there is a failure. The usual

setting is Auto-Select but WV-HTTP is set if the connection passes through a firewall (see p. 18).

• The timeout value when the camera server is connected by MV Station can be set with the "Connection

timeout" slide bar between 2 and 60 seconds in one second intervals.

• The upper limit for frame rate when the camera server is connected by MV Station can be set to a value

selected from the "Upper limit of framerate" box.

• Lets you confirm camera server address,

HTTP port (can be edited) and settings

page URL.

• Settings page can be opened with the

Open Setup Page button.

• The Administration Account button

produces a

display for

Administrator ID

and password.

These items can

be changed if there is a change in the

administration account.

• Lets you edit "Cameras server name" and

"Comment".

• Lets you confirm the type of camera server

and firmware version.

• View Test lets you confirm the images

from the cameras connected to the

camera server.

• Upgrade Firmware enables a remote

firmware upgrade to be performed (for

VB101 only).

• A list of monitoring screens in wich camera

servers are registered can be displayed for

confirmation.

●  General Tab

●  Network Tab
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For the VB150 (or the VB101), tabs will be

created for all cameras for which "Use this

Camera" is selected in the settings page. For

the VB-C10/VB-C10R, tab will be created for

Camera 1.

• Camera name can be edited. The camera

name entered in the camera server’s

settings page will be set by default.

• You can confirm the type of camera,

whether controlled or not, video capture

size, video qual i ty,  and whether a

wide-angle converter is used or not.

• Preset settings can be made with the

Setup Presets button.

• Auto Preset Tour settings can be made

with the Setup Auto Preset Tour button.

●  Camera Tab

Preset Settings

1 Preset angles can be set in the Presets Settings

dialog box by the following three methods:

(1) Click Display Viewer and specify angles by

operating the viewer that is displayed. Use the

Add button to capture that position as a preset.

(2) Click the New button and a yellow frame will

appear in the Preview window. Move pan and tilt

positions by dragging the yellow frame and

change the zoom value by dragging the edge of

the frame.

(3) Click the New button and change the values in

the "Pan", "Tilt" and "Zoom" boxes.

Registered presets will appear in the Presets. Select

by clicking a preset name and you can then alter the

angles by the three methods shown above. If you

wish to compensate for backlighting, select the

"Backlight Compensation" box.

2
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If the "Receive notification from external

device input" box is selected, the following

settings will be available.

• External device input icon allocated on the

camera tree, camera list or camera map

changes when an event notification is

received.

• You can select which camera to display

the image when notification of an event

was received.

• "Description" is text that is shown in the

MV Station external device input icon

captions and tool hints. The "External

Device Input Name" entered in the camera

server's settings page is set by default.

• You can specify the method of flashing the

viewer title of the camera that corresponds

to the input notification. When "Specify the

span" is selected, flashing will occur only

for the period set in the box. This can be

set between 0 and 99 seconds in one-

second increments. When set to "0",

flashing will continue until you click on the

viewer to select it. When "Blink during ON

event" is selected, flashing will continue

while it is on.

●  External Device Input Tab

Other Advanced Settings
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"Description" is text that is shown in the MV

Station external device output icon captions,

tool hints and in the "External Device Output

Control" dialog box. The "External Device

Input Name" entered in the camera server's

settings page is set by default.

●  External Device Output Tab

●  Motion Detection Tab
If the "Receive notification when motion is

detected" box is selected, the following

settings will be available.

• Motion detection icon allocated on the

camera tree, camera list or camera map

changes when an event notification is

received.

• If the "Display the corresponding video"

box is selected, and an event is received,

the image from the camera that detected

motion is allocated to the viewer and

displayed. If video relay is in progress, all

viewers display the video image from the

camera that detected the motion. Viewers

that are unable to allocate and display the

image either display a still picture or no

image at all (see p. 80).

• "Description" is text that is shown in the

MV Station motion detection icon captions

and tool hints.

VB150
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Other Advanced Settings

c
Note

If properties settings have been changed, they must be exported in order for

the settings to be reflected in monitoring screens (see p. 46).

Monitoring Screen Properties

• You can edit "Monitoring screen name"

and "Comment".

• You can confirm screen type, optimum

resolution and date-time of update.

• You can v iew and conf i rm v iewer

arrangements.

●  General Tab

Select monitoring screen and click the Properties button on the Toolbar to display Properties dialog

box. You can set monitoring screen details in properties.

• You can specify the method of

flashing the viewer title of the

camera that corresponds to the

motion detection notification.

When "Specify the span" is

selected, flashing will occur only

for the period set in the box. This

can be set between 0 and 99

s e c o n d s  i n  o n e - s e c o n d

increments. When set to "0",

flashing will continue until you

click on the viewer to select it.

When "Blink during ON event" is

selected, flashing will continue

while it is on.
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• You can select the cameras to be used.

Select by checking the boxes. Also, when

a camera server is selected directly, all

cameras connected to that camera server

will be selected. Deselect any cameras

that are not to be used.

• You can select from "MV Level", "MV

Level 2" or "Free viewer level" as the

camera control right level (see p. 105).

• If the motion detection is enabled on the

VB150, be sure to select the "Display the

corresponding v ideo when mot ion

detection is enabled" check box.

• You can start up Map Editor with the "Edit

map" button to edit maps. You can also

delete saved maps with the "Delete map"

button.

●  Details Tab

c
Note

In the MV Station, you can temporarily switch the control right level from MV

Level to MV Level 2 on the monitoring screen.

To switch the camera control rights

level to MV Level 2, right-click on the

viewer and select "MV Level2 Control

Right" from the menu. To revert to MV

Level, select "Revert to MV Level

Control Right".

The Free Viewer Level selected in the

monitoring screen cannot be changed

to MV Level or MV Level 2 in the MV

station.
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e
Tip

Camera Control Right Levels

Other Advanced Settings

The three types of camera control right level are MV Level, MV Level 2 and Free

Viewer Level. The choice between them should be made in accordance with your

purpose. Free Viewer is the viewer provided with the camera server product such as

the Viewer for Java (previous name: Java Viewer), Viewer for PC (previous name:

Helper Viewer), etc.

Besides these three types, there is also the Admin Viewer Level. The Admin Viewer

Level is the camera control right level that is applied if the camera server is accessed

from the Admin Viewer (the viewer provided with the camera server product) and has

priority over the MV Level, MV Level 2 and Free Viewer Level. For more information

about the Admin Viewer, see the manual supplied with the camera server.

MV Level

• If you wish to use all MV functions, choose MV Level.

• So long as there is no other client using Admin Viewer Level and MV Level, the

control right can be maintained for an unlimited period. If another client is connected

to the same camera server, the control right will move to the one connected later.

The control right cannot be obtained, however, if there is a client connected at the

Admin Viewer Level or MV Level 2.

• Some of the features of the Video Relay may be unavailable or camera control may

be limited while motion detection is being notified from the VB150 (see p. 80).

MV Level 2

• MV Level 2 is the camera control right level that has priority over MV Level and the

camera can be controlled irrespective of motion detection. If MV Level is being used

and motion detection is notified from the camera server, MV Level cannot take the

camera control right from motion detection since motion detection has priority over

MV Level. In this event, use MV Level 2 to temporarily obtain camera control right.

• The motion detection function will be limited in MV Station (see p. 83).

Free Viewer Level

• The period for maintaining the control right is limited to the period that is set in the

camera server.

• Control right at Free Viewer Level cannot be obtained if there is a user connected at

Admin Viewer Level or MV Level.

• Auto Preset Tour cannot be operated.

• External device input/output control cannot be operated.

• VBImageBrowser cannot be started up.

High priority
Admin Viewer

MV Level 2

Motion Detection

MV Level

Free Viewer Level
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1 The Main Video Pattern dialog box lets you allocate

cameras to viewers and freely specify positions for

presets to be displayed.

It shows a list of camera registered in Assignable

Cameras. Select by clicking the names of the

cameras you wish to allocate and it will be added to

the "Assignment to viewers" field when you click the

Assign button.

2

Main video pattern settings

Once the names of the cameras you wish to allocate

have all been allocated, select by clicking camera

names in the "Assignment to viewers" field and use

the Up and Down buttons to arrange them in the

viewer where you wish to display them. The viewer

for the number shown in "Viewer arrangement

preview" corresponds to the number in the

"Assignment to viewers" field.

Presets registered in the Preset box will be

displayed. Select the names of those you wish to

have displayed.

Click OK.

• The Settings button lets you set the video

pattern of the camera that is displayed in

the monitoring screen as a default.

• Lets you make Auto Switch settings (see

p. 70).

• Lets you specify whether to execute the

above settings when monitoring screen

has been selected in "Operation settings".

By selecting "Display main video pattern",

"Start Auto Preset Tour" and "Start Auto

Switch", they can be displayed and

started.

●  Video Pattern Tab
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MV Station and its Other Functions and Settings

Monitoring Screen Properties

• With Camera Control, you can select the

method of camera control on the viewer

screen (see p. 60).

• You can set the video relay interval.

Settings may be between 5 and 30

seconds in one-second increments.

●  General Tab

Select Properties on the File menu to display the Properties dialog box. Properties lets you set

monitoring screen details.

• If "Display the video" is selected, when

notification of external device input comes

from the camera server that is not

displaying the image, the image will be

displayed automatically.

• If "Play sound when the external device

input is notified" is selected, by specifying

with "Sound file" a sound file that can be

played back, a sound will be generated

when there is notification of external

device input.

●  External Device Input Tab

Option

• Timeout lets you set a timeout for the

connection with the camera server.

Settings may be between 5 and 60

seconds in one-second increments.

• With HTTP you can set HTTP port number

for communication with the camera server.

You can also make proxy settings with the

"HTTP proxy" button.

Select Option from the Tools menu to display the Option dialog box. You can make timeout and

HTTP settings under Option. You can make a connection passes through a firewall by using the

HTTP proxy.

Other Advanced Settings
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Option

Select Option from the Tools menu to display the Option dialog box. Under Option, you can specify

image recording folder and make HTTP proxy setting.

• MV Data folder and Start Screen can each

be verified.

• The "Image redording folder" is a folder for

images downloaded by VBImageBrowser.

You can change the image recording

folder by clicking the Change Folder button

and specifying a folder.

●  General Tab

• All MV Station traffic can be controlled in

Traffic with the slider.

• You can set a proxy with the HTTP Proxy

button.

●  Network Tab

●  Motion Detection Tab
• If "Display the video" is selected, when

notification of motion detection comes from

the camera server that is not displaying

the image, the image will be displayed

automatically.

• If "Play sound when detection of motion is

notified" is selected, by specifying with

"Sound file" a sound file that can be played

back, a sound will be generated when

there is notification of motion detection.

VB150
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• In MV Station you can make operation

restrictions enabled or disabled. When

enabled, the restrictions are cancelled by

entering a password. When the restrictions

are disabled, the operations restrictions

can be enabled by clicking Enable button.

●  Operation Restriction Tab

Other Advanced Settings
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Troubleshooting

■ Cannot install
● If Windows 2000 or Windows XP is being used, check to be sure log-in has been made with the administra-

tor.

● MV Manager cannot be installed in a PC where MV Station has already been installed. First uninstall MV

Station before installing MV Manager.

● MV Station cannot be installed in a PC where MV Manager has already been installed. First uninstall MV

Manager before installing MV Station.

● MV Manager/Station cannot be installed in a PC where VBCollector has already been installed. First uninstall

VBCollector before installing MV Manager/Station.

■ Cannot register camera server
● Refer to error messages (1) -(7).

● If the camera server is being accessed via a proxy, be sure to set the proxy in Option from the Tools menu  of

MV Manager.

■ Failed to search camera servers
● Camera server searches are performed by transmitting broadcast packets. Camera servers on networks

that cannot be reached by broadcast packets cannot be detected. Redo the camera server registration from

"Register Camera Server".

■ MV Station does not start up
● There is a possibility that the location of the MV Data folder was not correctly specified. Specify it correctly

and try starting up MV Station again.

■ Images are not displayed
● Refer to error messages (16) - (22).

● If connection to the camera server is being made via a proxy, be sure to set the proxy in Option from the

Tools menu of MV Station.

■ Cannot control the camera
● Make sure the RS-232C cable linking the camera server and the camera is correctly connected and power

to the camera is on.

● See if the camera server has been set not to control the camera.

● See if extreme view restrictions have been set for the camera server.

■ Created monitoring screen does not fit into display size
● The Display Size that was specified in the Create Monitoring Screen Wizard of MV Manager is larger than

the display size of the PC running MV Station. Specify a Display Size that is smaller than the display size of

the PC running MV Station.

■ The camera source window does not appear
● If Separated Window A or Separated Window B has been specified in the Create Monitoring Screen Wizard

of MV Manager, the camera source window does not appear as a default. Please select from the View

menu.

■ The camera control panel does not appear
● If United Window B or Separated Window B has been specified in the Create Monitoring Screen Wizard of

MV Manager, the camera control panel does not appear as a default. Please select from the View menu.
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Error Messages

MV Manager Error Messages

Message

Cause

Action to 
be taken

(1) Network connection errors (DNS errors): Camera server registration error [01]

The specified network address could not be found.

Could not find the camera server. Make sure:
• the network address is correct.
• DNS setting is correct.

• Enter the network address correctly.
• Set the DNS correctly.

Message

Cause

Action to 
be taken

(2) Network connection error (time out): camera server registration error [02]

The connection to the specified network address timed out.

Could not find the camera server. Make sure:
• the network address is correct.
• the camera server is turned on.
• the camera server is connected properly to your network.

• Enter the network address correctly.
• Turn on power to the camera server.
• Connect the camera server to the network correctly.
• Extend the timeout time set in the Option.

Message

Cause

Action to 
be taken

(3) Failed to retrieve camera server description: Camera server registration error [03]

Camera server description could not be retrieved for reasons such as the connection 
target was not a camera server.

Could not find the camera server. Make sure:
• the camera server is compatible with WebView Livescope MV Ver.2.1.
• the network address is correct.
• the camera server is connected properly to your network.

• Connect to the camera server that is compatible with WebView Livescope MV Ver. 2.1.
• Enter the network address correctly.
• Connect the camera server to the network correctly.

Message

Cause

Action to 
be taken

(4) Connected to a camera server with old version of firmware: 
   camera server registration error [04]

The version of the firmware in the camera server is old.

Could not retrieve a description from the camera server. Make sure:
• the camera server is compatible with the WebView Livescope MV Ver.2.1.
• Firmware of VB101 is version 3.0 or later.

• Connect to a camera server that is compatible with WebView Livescope MV Ver. 2.1.
• Upgrade the VB101 firmware to 3.0 or later.
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Message

Cause

Action to 
be taken

(5) VIEW-Windows mode: Camera server registration error [05]

The camera server application mode is set to VIEW-Windows mode.

The camera server is not set up properly. Make sure:
• [Target Application] of [Basic Settings] is set to [WebView Livescope].

Set the camera server application mode to WebView Livescope mode.

Message

Cause

Action to 
be taken

(6) Access restrictions at the camera server: Camera server registration error [06]

Access restrictions have been set at the camera server.

Could not retrieve a description from the camera server. Make sure:
• your computer is authorized to access the camera server.
• the network address is correct.

Make sure access to the camera server is authorized and that the network address 
has been correctly entered.

Message

Cause

Action to 
be taken

(7) Other connector error: Camera registration error [07]

A camera registration error other than errors [1] - [6]. A malfunction may have 
occurred on the network.

Could not retrieve a description from the camera server.

Consult the network administrator.

Message

Cause

Action to 
be taken

(8) Administrator account authentication failed

Authentication failed due to invalid administrator ID or password.

Administrator ID or password is invalid.

Enter the correct administrator ID or password.

Message

Cause

Action to 
be taken

(9) If offline

Camera server description could not be retrieved, because connection to 
the network was cut or power to the camera server was off.

Failed to retrieve the description of ***. Properties will be displayed offline.
(*** = camera server name)

• Reconnect to the network.
• Turn on power to the camera server.
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Error Messages

Message

Cause

Action to 
be taken

(10) If the saved administrator ID or password is invalid

Administrator authentication while connecting to the camera server failed when 
the properties were being opened.

Administrator authentication for ***s failed. Click Administrator Account in Network 
tab, then re-enter the correct administrator ID and the password.
(*** = camera server name)

Click the Administration Account button in the Network tab and re-enter the correct 
administrator ID and password.

Message

Cause

Action to 
be taken

(11) When camera information cannot be retrieved due to power cut, etc.

Camera information could not be retrieved, because power to the camera was 
turned off or other reason.

Camera information could not be retrieved. Preset-setting is now unavailable.

Turn on power to the camera.

Message

Cause

Action to 
be taken

(12) When camera information cannot be retrieved due to power cut, etc.

Camera information could not be retrieved, because power to the camera was 
turned off or other reason.

Camera information could not be retrieved. Auto Preset Tour setting is now unavailable.

Turn on power to the camera.

Message

Cause

Action to 
be taken

(13) Failed to write onto export target

When the data was exported, the disk was write-protected or full.

Failed to export MV data.

• Release write protection on the disk.
• Secure sufficient space on the disk.

Message

Cause

Action to 
be taken

(14) Background image failed to load

The specified background image is in a format other than BMP or JPG.

Cannot read this file. Its format is not supported.

Specify a BMP or JPG file for the background image.
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MV Station Error Messages

Message

Cause

Action to 
be taken

(15) When the background image view size has reached the maximum

The specified background image size is larger than the maximum view size of 1280 x 1024.

This file exceeds the maximum view size (1280 × 1024). Specify another file.

For the background image, specify a file with a view size smaller than 1280 x 1024.

Message

Cause

Action to 
be taken

(17) When switching to appropriate camera failed during assignment

An attempt was made to assigned a camera that is different from the camera 
being viewed by a client with control rights of a higher level than yourself.

Could not switch camera.

Ask the other client to release the camera control privileges.

Message

Cause

Action to 
be taken

(16) Could not get in camera control right queue

Another client with camera control privileges of a higher level than yourself is 
connected to the camera server.

Could not get in camera control right queue.

Ask the other client to release the camera control privileges.

Message

Cause

Action to 
be taken

(18) Power to the camera is turned off or there is a malfunction

Power to the camera is off, or a cable is not properly connected.

Camera is switched off or faulty.

• Turn on power to the camera.
• Connect the cable.

Message

Cause

Action to 
be taken

(19) Incorrect address

Network connection was cut, power to the camera server was cut, or the proxy 
settings are not correct.

Could not connect to the camera server.

• Re-connect to the network.
• Turn on power to the camera server.
• Redo the proxy settings.
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Error Messages

Message

Cause

Action to 
be taken

(20) Access restrictions at the camera server

Access restrictions have been set at the camera server.

Your computer is not authorized to access the camera server.

Release the access restrictions.

Messeage

Cause

Action to 
be taken

(21) Maximum allowed number of camera server connections has been exceeded

The number of access to the camera server has been reached.

Number of accesses to the camera server has reached to the maximum.

Wait until the number of access decreases.

Message

Cause

Action to 
be taken

(22) Incorrect administrator ID or password (MV level only)

The administrator ID or password at the camera server has been changed.

Administrator ID or password of the camera server is invalid.

Change the administrator ID or password at the camera server or at MV Manager.

Message

Cause

Action to 
be taken

(23) Connection cut at camera server

Connection with the network was cut, or power to the camera server was cut.

Disconnected.

• Re-connect to the network.
• Turn on power to the camera server.

Message

Cause

Action to 
be taken

(24) If browse target is not valid

MV data has not been placed in the specified folder.

MV Data cannot be found.

Specify the correct folder, or export the data.

Message

Cause

Action to 
be taken

(25) Incorrect password

The wrong password was entered.

The password is invalid.

Enter the correct password.
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A

Administrator ID 22,25,99,114,117

Admin Viewer Level 105

Animation Control 90

Auto Preset Tour 51,68,70,75,76,100,105,106,

115

Auto Switch 52,70,72,76,106

B

Background image 40,115,116

Backup 65,86,90,95

C

Camera Control Right 31,51,81,82,104,116

Camera Control Panel 33,50,53,57,112

Camera Icon 42,44,55,58,60

Camera List 51,56,79,81,102

Camera Server Icon 26,42,55,64,68,84

Camera Server Name 23,26,31,42,94,99,114

Camera Source Window 33,50,53,55,56,58,60,

112

Camera Tree 51,56,79,81,102

Comment  23,31,99,103

Connection Timeout 99

D

Display Size 30,112

E

Error Message 23,113

Exif 86,97

Export 9,12,20,28,32,44,46,48,50,54,69,72,103,115

External Device Icon 43

External Device Input 14,52,78,83,84,97,98,101,

105,107

External Device Output 14,52,79,97,102

F

Frame rate 62,99

Free Viewer Level 68,83,104,105

Full Screen 51,61

H

HTTP port 22,99,107

I

Image Comparison 87,92

Interval 70,72,75,76,107

M

Maximum Number of Clients 14

Menu 20,28,40,50,85

Motion Detection 5,40,42,73,80,83,84,98,102,108

MV Data folder 9,12,13,46,48,50,54,108

MV Level/ MV Level 2 31,68,81,83,104,105,117

N

Navigation bar 20,28

Network address 22,113,114

Network Information 51,62

NU-700 5,43,59

O

Operation Restriction 48,109

P

Panorama 50,57,59

Password 22,25,48,99,109,114,117

Preset 58,68,100,106,115

Preview 86,89

Property 20,28,50,86,99,103,107

Proxy 14,18,29,62,107,108,112,116

Index
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S

Schedule 69,83,84,86

Scope 44,58,60

Screen Configuration 20,28,40,50,85

Separated Window 33,34,53,57,112

Snapshot 51,61

Sort by Similarity 86,93

Start Screen 46,48,54,108

T

Task View 87,88

Toolbar 20,28,50,85

U

United Window 33,34,53,57,112

V

VB101 5,10,14,21,23,26,43,65,100

VB150 5,14,43,59,73,77,80,100,104

VB-C10/R 5,14,23,43,73,100

VBCollector 87,88,112

VBImageBrowser 85,86,88,98,105,108

Video Indicator 58,77

Video Input Setting (Single/ Multiple) 5,73,77

Video Pattern 48,70,72,76,106

Video Relay 73,74,76,78,81,102,105,107

Viewer Arrangement 30,33,71,103,106

View Test 21,24,26,64,99

W

Work folder 17

WV-HTTP 62,99

WV-TCP 18,59,62,99
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